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概要

ParaViewは、大容量のデータセットを並列に分析および可視化することのでき
る、パワフル、オープンソース、かつダウンロード後即座に使用可能なアプリケー
ションです。ParaViewはRed StormやASC Purpleスーパーコンピュータによるシ
ミュレーション結果の可視化のために、サンディア国立研究所のアナリストによっ
て日常的に使用されており、さらにその他の、世界中の何千ものユーザによっても
使用されています。柔軟な設定・拡張が可能であり、またスケーラブルな設計を目
指し、ParaViewは Visualization Toolkit (VTK)の上に構築され、それゆえ可視化
コンポーネントの迅速な適用が可能です。このチュートリアルでは、ParaViewの
構造および並列可視化の基礎を学びます。実践的な演習によって、読者が科学デー
タ可視化のための ParaViewの使用法の基礎を学ぶことを目的としています。この
チュートリアルは、現在のスーパーコンピュータで実行されるような大規模シミュ
レーションを可視化するための詳細な方法、およびParaViewにおけるスクリプティ
ングおよび拡張法を特に取り上げます。
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第1章 序

ParaViewは、2次元および 3次元データセットを可視化するためのオープンソー
スアプリケーションです。ParaViewが扱えるデータセットの大きさは、ParaViewが
実行されるプラットフォームのアーキテクチャによって大きく変わります。ParaView

によってサポートされるプラットフォームは、シングルプロセッサのワークステー
ションから、多数のプロセッサによって構成される分散メモリスーパーコンピュー
タやワークステーションクラスタまで、多岐に渡ります。並列コンピュータを利用
することで、ParaViewは巨大なデータセットを並列に処理し、その後で処理結果を
集約することが出来ます。今までのところサンディア国立研究所では、最大で 60億
セルの構造化メッシュ、2億 5千万セルの非構造メッシュ、そして数十億のセルから
なる構造AMR格子の可視化に ParaViewを使用しています。

ParaViewの設計においては、以下のような多くの特徴により、他の科学データ可
視化ソリューションとの差別化を図っています。

• オープンソース、スケーラブル、かつマルチプラットフォームな可視化アプリ
ケーション。

• 大容量データセットを処理するための分散型計算手法のサポート。

• オープン、柔軟かつ直感的なユーザインターフェイス。

• オープンな規格に基づいた拡張性の高いモジュール化構造。

• 有償の保守およびサポート。

ParaViewは世界中の多くの学術、公的、および商業機関によって利用されてお
り、毎月およそ 3千件ダウンロードされています。
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ParaViewとしてユーザから見えるアプリケーションの実体は、ParaView自体の
機能を構成する何層ものライブラリ群の上に構築された、小さなクライアントに過
ぎません。上の図に示すように、ParaViewのほとんどの機能はライブラリとして実
装されているため、ParaViewのGUIをカスタムアプリケーションによって完全に
置き換えることが可能です。さらに、ParaViewに付属する pvpythonアプリケー
ションによって、Pythonスクリプトを用いて可視化とポストプロセッシングを自動
化することが可能です。

ParaViewアプリケーションのそれぞれに対し、コードを最大限に共有化するため
のユーザインターフェイス部品のライブラリが利用可能です。ParaViewサーバ・
ライブラリによって、並列かつインタラクティブな可視化を実行するための抽象化
レイヤが提供されます。ParaViewサーバ・ライブラリによって、クライアントアプ
リケーションはParaViewが並列に実行されているか否か、またどのように並列実行
されているか、といったことに関する問題の多くから解放されます。Visualization

Toolkit (VTK) は、基本的な可視化およびレンダリング・アルゴリズムを提供し
ます。VTKにはレンダリング、並列処理、ファイル入出力、並列レンダリングのよ
うな基本的な機能を提供するライブラリも含まれます。このチュートリアルでは、
ParaViewに付属するクライアントアプリケーションを使用してParaViewの使い方
を説明しますが、ParaView自体は、その高度に部品化された設計によって、大幅な
柔軟性およびカスタマイズの可能性を有しています。

1.1 開発および資金提供
ParaViewのプロジェクトは、Kitware Inc.とロスアラモス国立研究所の共同努力
によって開始されました。初期の資金は、米エネルギー省 ASCI Views計画との 3

年契約によって提供されました。最初の公開リリースであるParaView 0.6は、2002
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年 10月にアナウンスされました。ParaViewの開発は、Kitware Inc.とサンディア
国立研究所、ロスアラモス国立研究所、陸軍研究所、およびその他多くの学術・政
府機関との共同作業によって継続されました。

2005年 9月には、Kitware、サンディア国立研究所、およびCSimSoftはParaView

3.0の開発を開始しました。この開発においては、ユーザインターフェイスをさらに
ユーザフレンドリに書き直し、定量解析のためのフレームワークを開発することに
注力しました。ParaView3.0は 2007年 5月にリリースされました。

ParaViewの開発は、今日も続いています。サンディア国立研究所は、ASC計画を通
じ、ParaViewの開発への資金提供を続けています。ParaViewは、SciDAC Institute

for Ultra-Scale Visualization (www.ultravis.org)の主要な開発プラットフォームとし
て統合されています。米エネルギー省は、ロスアラモス国立研究所、陸軍の中小企
業技術革新制度、およびERDCとの契約を通じてParaViewに資金提供しています。
米国立科学財団もまた、中小企業技術革新制度によってParaViewに資金提供してい
ます。フランス電力公社、Mirarco、石油関連企業など、その他の機関も ParaView

への支援を行っています。さらに、ParaViewはオープンソースプロジェクトである
ため、スイス国立スーパーコンピューティングセンターのような機関も開発成果を
コントリビュートしています。

http://www.ultravis.org
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1.2 可視化の基礎

簡単に言うと、可視化の過程とは、生のデータを人間が見て理解することができ
る形式に変換することです。このことによって、データをより感覚的に理解するこ
とができるようになります。科学的な可視化では特に、2次元あるいは 3次元空間
において明確な表現を有するデータを取扱います。シミュレーションのメッシュや
スキャナのデータに由来するデータは、この種の分析に特に向いています。
データの可視化には、大別して 3つの段階があります。すなわち、読込み、フィル
タリング、レンダリングです。まず、データを ParaViewに読み込みます。つぎに、
データから特徴を生成、抽出、導出するためにデータを処理するフィルタを、必要
なだけ適用します。最後に、可視化された画像がデータからレンダリングされます。

ParaViewは空間的な表現としてデータを取扱うため、ParaViewが使用する基本
的なデータ型はメッシュ (または格子) です。

一様直線格子 (画像データ)

等間隔直線格子は 1、2、または 3次元の配列デー
タです。格子点は互いに直交し、各方向に等間隔に
配置されます。
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非一様直線格子 (直線格子)

等間隔直線格子と似ていますが、格子点間の距離
を各軸方向に変化させることができます。

曲線格子 (構造格子)

曲線構造格子は、直線格子と同じトポロジを有し
ます。ただし、曲線格子上の格子点は (セルどうし
が重なったり、自分自身と交差しない限り) 任意の
座標に置くことが出来ます。曲線格子は直線格子の
比較的少ないメモリ使用量、暗黙のトポロジといっ
た特徴を継承しつつ、メッシュの形状に大幅な自由
度を与えることができます。

ポリゴン・データ (ポリ・データ)

ポリゴン・データセットは、点、直線、2次元の任
意多角形から構成されます。セル間の結合は任意で
あり、結合しないこともできます。
レンダリングにおける基本的なプリミティブは、ポ
リゴン・データによって表されます。全てのデータ
は、(ボリュームレンダリングを除いて) レンダリ
ングの前に必ずポリゴン・データに変換されます
が、この変換はParaViewによって自動的に行われ
ます。

非構造格子
非構造格子データセットは、点、直線、2次元の任
意多角形、3次元 4面体、非線形セルから構成され
ます。ポリゴン・データと類似していますが、直接
レンダリング出来ないような、3次元の 4面体や非
線形セルも表現することができます。

これらの基本的なデータ型に加えて、ParaViewはマルチブロックデータもサポー
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トしています。データセットがグループ化されたときや複数のブロックから成るファ
イルが読み込まれた時には、必ずマルチブロックのデータセットが生成されます。Par-

aViewはさらに、階層化適応メッシュ分割(AMR)、階層化一様AMR、八分木デー
タセットを表現するためのデータ型を有します。

1.3 さらなる情報
様々なところから、ParaViewに関するさらなる情報を入手することができます。
初心者には、ParaViewアプリケーションの ボタンをクリックすることでアクセ
ス可能な、オンライン・ヘルプがあります。このオンライン・ヘルプに加え、Amy

Henderson Squillacoteによって書かれ、Kitwareから入手可能なThe ParaView Guide

は、ParaViewの全てに関するガイドとして役立ちます。
ParaViewのウエブページwww.paraview.orgもまた、ParaViewに関するさらなる
情報を入手する絶好のサイトです。このサイトから、メーリングリスト、Wiki、よ
くある質問集、さらには有償サポートサービスへのリンクを辿ることができます。

http://www.paraview.org
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それでは、ParaViewを使ってみましょう。ここから先の内容を進めるには、Par-

aViewをインストールして頂く必要があります。既に ParaViewをお持ちでなけれ
ば、www.paraview.orgからダウンロードすることができます (ダウンロードへのリ
ンクをクリックして下さい)。ParaViewは、大抵のアプリケーションと同じように
して起動します。Windowsでは、スタート・メニューから起動します。Macintosh

では、インストールしたアプリケーションバンドルを開いて下さい。Linuxでは、コ
マンドプロンプトから paraviewを実行して下さい (パスが設定されている必要があ
ります)。
このチュートリアルの例では、http://www.paraview.org/Wiki/SC08 ParaView

Tutorial から入手可能なデータを使用します。このデータを、簡単にアクセス出来
る適当なディレクトリにインストールして下さい。このチュートリアルによってファ
イルを読み込むよう指示された時は、このデータをインストールしたディレクトリ
から読み込んで下さい。

2.1 ユーザインターフェイス

ParaViewのGUIは、実行されているプラットフォームにおける形式 (ルック・ア
ンド・フィール) に従いますが、基本的には全てのプラットフォームで同じように
操作します。ここに示したレイアウトは、ParaViewが最初に起動された時のデフォ
ルトのレイアウトです。GUIは以下の要素から構成されます。

http://www.paraview.org
http://www.paraview.org/Wiki/SC08_ParaView_Tutorial
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メニューバー 他のプログラムと同様に、メニューバーから大部分の機能を利用する
ことが可能です。

ツールバー ツールバーによって、ParaViewの中でも最も一般的に使用される機能
を素早く利用することができます。

Pipeline Browser (パイプライン・ブラウザ) ParaViewは、パイプラインによっ
てデータの読み込みとフィルタリングを管理します。パイプライン・ブラウザ
によって、パイプラインの構造を表示し、パイプライン・オブジェクトを選択
することができます。ParaView 3のための再設計によって、パイプライン・ブ
ラウザは、パイプライン構造をインデントして表現する便利なリストとなりま
した。

Object Inspector (オブジェクト・インスペクタ) オブジェクト・インスペクタで
は、現在選択されているパイプライン・オブジェクトの設定を表示および変更
することができます。オブジェクト・インスペクタには、3つのタブがあります。
Properties (プロパティ) タブには、オブジェクトの状態に関して設定可能な
オプションが提示されます。Display (ディスプレイ)タブには、ビュー画面で
のオブジェクトの表現方法に関するオプションが提示されます。Information

(情報) タブには、パイプライン・オブジェクトによって生成されたデータに関
する基本的統計情報が表示されます。

3D View (3Dビュー) GUIの残りの部分はデータの提示に使用され、ここでデー
タを表示・操作・分析することができます。この部分は、データの幾何的表現
を提示する 3D Viewで初期化されます。

ここで留意すべきは、GUIのレイアウトは大幅に設定変更が可能であり、そのた
めウインドウの見た目の変更が容易であることです。ツールバーは各所に移動し、
あるいは隠すこともできます。ツールバーの表示を変更するには、View → Toolbars

メニューを使用して下さい。パイプライン・ブラウザとオブジェクト・インスペク
タは、いずれもドック可能なウインドウです。すなわち、これらの要素はGUIの中
を各所に移動したり、フローティング・ウインドウとして切離したり、完全に隠す
ことができます。これらの 2つのウインドウは ParaViewの操作に重要なので、こ
れらを隠した後に再度必要となった場合は、Viewメニューから表示することができ
ます。

2.2 ソース
ParaViewにデータを入力するには、2とおりの方法があります。すなわち、データ
をファイルから読み込むか、またはソースオブジェクトによって生成する方法です。
全てのソースはSourceメニューにあります。ソースによって例えば、ビューに注記を
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追加することもできますし、ParaViewの機能を (実際に動作させながら)調べたい時
にも非常に便利です。簡単な例から始めましょう。Sourceメニューから、Cylinder (シ
リンダ) を選択して下さい。そうすると、パイプライン・ブラウザにCylinderSource1

という項目が追加され、選択された状態となります。さらに、オブジェクト・イン
スペクタには、シリンダ・ソースのプロパティが表示されています。ここではデフォ
ルトの設定で良いので、Apply ボタン をクリックして下さい。

Applyをクリックすると、シリンダ・オブジェクトが 3Dビューウインドウの右側
に表示されます。この 3Dビューは 3Dビュー上でマウスドラッグすることで、操作
することができます。回転、パン、ズーム等の操作を行うには、異なるマウスのボタ
ン (左、中、右)を押しながらのドラッグを試してみて下さい。また、シフト、Ctrl、
Altキーなどのモディファイアキーを押しながらマウスボタンを押してみて下さい。
シリンダ・オブジェクトは真の円筒ではなく、多角形小面による円筒の近似であ
ることにお気づきと思います。シリンダ・ソースのデフォルト設定では、わずか 6

小面からなる非常に粗い近似が生成されます。(実際のところ、このオブジェクトは
円筒というよりプリズムに近く見えます。) より円筒らしい表現が必要であれば、
Resolutionのパラメータ値を増やすことで作成することができます。

スライダもしくはテキスト入力フィールドを使用して、解像度を 50、またはそれ
以上にして下さい。ここで、Applyボタン が再び緑色 (または、Macでは
青色) になったことに留意して下さい。これは、オブジェクト・インスペクタに対
して行った変更がすぐには適用されないためです。ハイライト状態のボタンは、パ
イプライン・オブジェクトのいずれかの設定と、表示されているデータが整合して
いないことを示しています。Applyボタンをクリックするとこれらの変更が適用さ
れ、Resetボタン は、設定を最後に適用された状態に戻します。ここでは、
Applyボタンをクリックして下さい。真の円筒とほとんど見分けがつかない程、解
像度が変わる筈です。
ここで ParaView 3の新機能である、ツールバーの取消し および再実行
ボタンを紹介します。データの可視化は多くの場合試行錯誤の過程であり、一つ前
の状態に戻れることが有用な状況があります。実際、データを作成する前の時点に
まで取消しで戻って、再実行を行うことができます。この操作を、ここで試してみ
て下さい。さらに、カメラ操作の取消し 、カメラ操作の再実行 という特別
なボタンもあります。これらによって、今までに試行したカメラのアングルを行っ
たり来たりすることができ、マウス操作の誤りによって完璧なカメラアングルが崩
れることを心配する必要がなくなります。
また、オブジェクトがどのようにレンダリングされるかを選択するための設定も、
多数あります。3Dビューの上には ボタンがあり、レンダリングの設定を変更す
ることができます。これをクリックするとダイアログボックスが開き、背景色、ラ
イティング、注釈などを変更することができます。
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オブジェクト・インスペクタのDisplayタブにも注目して下さい。このタブには、
選択したオブジェクトのレンダリング設定があります。例えば表示・非表示の切替
え、表示色、データセットの表現方法などを設定できます。利便性のため、これら
のビュー設定の幾つかとオブジェクトの表示設定は、ParaViewのGUI上の他の場
所 (ツールバー) にも存在します。

シリンダ・ソースについては以上です。オブジェクト・インスペクタの Properties

タブを選択し、削除 をクリックすることで、パイプライン・オブジェクト
を削除することができます。

2.3 データの読込み
ParaViewのGUIはいくらか練習しましたので、実際のデータを読込んでみましょ
う。ご想像のとおり、Fileメニューの最初の項目にOpenコマンドがあり、さらにツー
ルバーにもファイルを開くためのボタンがあります。ParaViewは多くのファイル形
式をサポートし、ファイル形式のリストは新たな形式が追加される度に長くなって
います。以下は現在のところ利用可能な読込みモジュールです。

• ParaView Data (.pvd)

• VTK (.vtp, .vtu, .vti, .vts, .vtr)

• VTK Multi Block (.vtm, .vtmb,

.vtmg, .vthd, .vthb)
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• Partitioned VTK (.pvtu, .pvti,

.pvts, .pvtr)

• VTK Legacy (.vtk)

• Exodus

• XDMF (.xmf, .xdmf)

• LS-DYNA

• SpyPlot CTH

• EnSight (.case, .sos)

• BYU (.g)

• Protein Data Bank (.pdb)

• XMol Molecule

• PLOT3D

• Digital Elevation Map (.dem)

• VRML (.wrl)

• PLY Polygonal File Format

• Stereo Lithography (.stl)

• Gaussian Cube File (.cube)

• POP Ocean Files

• AVS UCD (.inp)

• Meta Image (.mhd, .mha)

• Facet Polygonal Data

• Phasta Files (.pht)

• PNG Image Files

• Raw Image Files

• Comma Separated Values (.csv)

モジュール化されたParaViewの設計によって、新たなVTKの読込みモジュール
のParaViewへの統合が容易になっています。従って、新たなファイルフォーマット
がサポートされていないか頻繁にチェックされることをお勧めします。もしお探しの
ファイル読込みモジュールがParaViewに含まれていないようであれば、ParaView

メーリングリスト (paraview@paraview.org) で調べてみて下さい。ParaViewから
は見えないものの、VTKには含まれており、容易に追加出来るファイル読込みモ
ジュールも多数あります。さらには VTKフレームワークへの組み込みが可能であ
りながら、VTKにはまだ組み込まれていない読み込みモジュールも多数あります。
誰かがあなたの必要な読込みモジュールをそのような形で持っており、快く提供し
てくれるかもしれません1 。
それでは、初めてのファイルを開いてみましょう。Openツールバー (もしくはメ
ニュー項目) をクリックし、disk out ref.ex2を開いて下さい。ファイルを開く操作は
2段階の操作であり、この段階では、まだ読込んだデータは見られないことに注意
して下さい。その代わり、オブジェクト・インスペクタに、どのようにデータを読
込むかを指定するための設定が提示されています。

1訳注: 例えば、訳者の一人の大嶋は、以下でOpenFOAM-1.5以降に対応したOpenFOAMフォー
マットの並列読込みモジュールを公開しています (2009年 8月現在)。
http://openfoamwiki.net/index.php/Contrib Parallelized Native OpenFOAM Reader for ParaView

mailto:paraview@paraview.org
http://openfoamwiki.net/index.php/Contrib_Parallelized_Native_OpenFOAM_Reader_for_ParaView
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Variables (変数) リストのヘッダ (最上部) にあるチェックボックスをクリックし、
全ての変数が読込まれるようにして下さい。これは小さいデータセットですので、メ
モリに読み込むデータ量が過大になることを心配する必要はありません。全ての変
数を選択したら、 をクリックして全てのデータを読込んで下さい。データ
が読込まれたら、一方がくり抜かれた円筒のような形状が表示されます。このデー
タは、加熱された回転ディスク周囲の気流シミュレーションの結果です。表示され
ているメッシュはディスク周りの空気で、シミュレーションの領域境界が円筒形に
なっています。真ん中のくり抜かれた領域は、もしこのシミュレーションのためにこ
の部分もメッシングされていれば、加熱されたディスクが存在するはずの場所です。
データのフィルタリングに進む前に、データの表現方法の幾つかを簡単に見てお
きましょう。データの表現に関する最も一般的な設定は、2つのツールバーに配置
されています。

データの表現方法を幾つか試してみて下さい。変数選択 (上図のMapped Variable)

を使用して、表面を Pres変数で色付けしてみて下さい。次に色の凡例表示 (上図の
Toggle Color Legend) をオンにして、実際の圧力の値を見てみて下さい。メッシュ
の構造を見るには、表現方法 (上図のRepresentation) を Surface With Edgesにしま
す。Wireframe表現にすると、セル構造とメッシュの内部を見ることができます。
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2.4 フィルタ
これまでのところ、とりあえずはデータの読込みに成功し、そのデータの情報を
幾らか見ることができました。つまり、メッシュの基本的な構造を表示し、メッシュ
の表面に何らかのデータをマッピングできるようになりました。しかしながら、こ
れから見るように、データの表面をただ眺めるだけでは判らない興味深い特徴が、
このデータには多数あります。(スカラーやベクトルのような) 異なった型の多くの
変数が、このメッシュには関連づけられています。さらに、メッシュはソリッド (中
実) なモデルであることに注意して下さい。興味深い情報の多くは、内部に存在し
ています。
フィルタを適用することで、データに関してさらに多くのことを発見できます。
フィルタとは、データから特徴を生成、抽出、または導出するためにデータを処理
する機能ユニットです。フィルタは読込みモジュール、ソース、あるいは他のフィ
ルタに接続され、それらのデータに対し何らかの形で変更を加えます。これらの互
いに接続されたフィルタによって、可視化パイプラインが形成されます。ParaView

では、非常に多数のフィルタが利用可能です。以下は対応するフィルタ・ツールバー
上のアイコンをクリックすることで利用出来る、最も一般的なフィルタです。

Calculator (電卓) 格子点またはセル毎に、ユーザによって定義された数式を
評価します。

Contour (コンター) スカラー場がユーザによって指定された値に等しくなる
ような点、曲線、面を抽出します。この面は等値面とも呼ばれます。

Clip (クリップ) 形状を半空間で切断します。その結果、ユーザによって定義
された面のいずれか一方の側の形状が削除されます。

Slice (スライス) 形状を面で切断します。その結果はクリップと同様ですが、
面上の形状だけが残されます。

Threshold (しきい値) スカラー場の指定された範囲に存在するセルを抽出し
ます。
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Extract Subset (サブセットの抽出) 抽出すべきボリュームあるいは間引き
率を指定し、格子のサブセットを抽出します。

Glyph (グリフ) グリフ、すなわち単純な形状をメッシュの各格子点に配置し
ます。グリフはベクトルによって方向を指定し、ベクトルまたはスカラーに
よってスケーリングすることができます。

Stream Tracer (流線追跡) ベクトル場にシード点を配置し、(定常の)ベクト
ル場をそれらのシード点から追跡します。

Warp (vector) (ワープ (ベクトル)) メッシュの各格子点を、与えられたベク
トル場で変形させます。

Group Datasets (データセットのグループ化) 複数のパイプライン・オブジェ
クトの出力を、一つのマルチブロック・データセットに統合します。

Extract Group (グループの抽出) マルチブロック・データセットを構成する
要素 (ブロック) を抽出します。

これらの 11種のフィルタは、ParaViewで利用可
能なもののごく一部の例です。Filtersメニューには、
データ処理のためのフィルタがさらに多数存在しま
す。ParaViewからは現在のところ 80以上のフィルタ
が利用可能であるため、簡単にフィルタを見つけられ
るよう、Filtersメニューは以下のようにサブメニュー
に整理されています2。

Recent (最近使ったフィルタ) 最も最近使われたものが一番上に来るようソートさ
れた、最も最近使われたフィルタのリストです。

Common (一般的) 最も一般的なフィルタです。これはフィルタ・ツールバーにリ
ストされているフィルタと同じで、前述のとおりです。

Data Analysis (データ分析) 定量的な値をデータから取り出すためのフィルタで
す。これらのフィルタはメッシュ上でデータを計算したり、メッシュから要素
を抽出したり、データをプロットするのに使用します。

Temporal (時間依存型) 時間によって変化するデータを分析、あるいは加工する
フィルタです。全てのフィルタは各時刻のスナップショットに対して実行され
るため、時間によって変化するデータに対して使用可能です。しかしながらこ
の分類のフィルタは特に、利用可能な時間範囲を走査し、データが時間ととも
にどのように変化しているかを調べることができます。

2訳注: フィルタが多すぎて探しにくい場合は、Ctrl + Space (MacではOption + Space) のキー
操作によって、フィルタ名で検索することもできます。
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Alphabetical (アルファベット順) 全ての利用可能なフィルタのアルファベット順
のリストです。あるフィルタがどこにあるか判らなければ、このリストには確
実に存在します。また、このリストにしか存在しないフィルタも多数存在し
ます。

フィルタの一部はメニュー上でグレーになっていて、選択できないことにお気づ
きかと思います。多くのフィルタは特定の型のデータにしか適用できないため、常
に使用出来る訳ではありません。ParaViewはそのようなフィルタをメニューおよび
ツールバーから選択不可にし、それらのフィルタが使用不可であることを示し (ま
た、それを強制し) ます。
このチュートリアルでは多くのフィルタを使用しますが、それでも全てを試せる
訳ではありません。それぞれのフィルタのさらなる情報については、The ParaView

Guideをご覧下さい。
それでは最初のフィルタを適用しましょう。パイプライン・ブラウザ上で disk out

ref.ex2が選択されていることを確認し、フィルタ・ツールバーまたはFiltersメニュー
から、Contour フィルタを選択して下さい。パイプライン・ブラウザの読込み
モジュールの下に新たな項目が追加され、オブジェクト・インスペクタはフィルタ
の設定画面にアップデートされます。ファイルの読込みと同様に、フィルタの適用
も 2段階の操作です。フィルタの作成後、フィルタの適用前に設定を変更すること
ができます (そしてそれはほぼ大抵の場合、必要な操作です)。

コンター・フィルタを使って、温度が 400 Kの等値面を作成することにしましょ
う。まず、Contour Byの設定をTemp変数に変更します。つぎに、等値面の値を 400

に変更します。最後に、 をクリックします。等値面がボリュームの内部に
現れる筈です。等値面はフィルタへの入力となった disk out ref.ex2と同様に、圧力
で色付けされています。
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もう少し、フィルタを色々試してみましょう。内部にあるものの表示をしばしば
妨げるメッシュ表面のワイヤフレーム表示の代わりに、表面の一部を切り取った状
態にしましょう。この操作には 2つのフィルタが必要です。すなわち、1つ目のフィ
ルタで表面を抽出し、2つ目で表面の一部を切り取ります。
それでは表面を抽出するフィルタを追加しましょう。それは以下の手順で行います。

1. パイプライン・ブラウザで disk out ref.ex2を選択します。

2. メニューバーから Filters → Alphabetical → Extract Surfaceを選択します。

3. ボタンをクリックします。

ワイヤフレームはソリッドな表面で置き換えられました。コンターが見えなくな
りましたが、心配する必要はありません。表面に隠された状態で、そのまま存在し
ています。もしフィルタの適用後の表示に何も変化が無ければ、1番目の disk out

ref.ex2を選択する操作を忘れて、違うオブジェクトにフィルタを適用したのかもし
れません。もし ExtractSurface1オブジェクトが disk out ref.ex2に直接接続されてい
なければ、それが間違えた操作です。もしそのとおりであれば、フィルタを削除し
て再び操作を行うことができます。
つぎに内部の等値面が見えるよう、表面を切り取りましょう。

1. パイプライン・ブラウザ上で、ExtractSurface1が選択されていることを確認し
ます。
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2. Clip フィルタを、ツールバーまたは Filtersメニューから作成します。

3. オブジェクト・インスペクタの Show Planeチェックボックス の
チェックを外します。

4. ボタンをクリックします。

これでメッシュ表面を切り取った内側から、等値面コンターが見える筈です。コン
ターがはっきり見えるためには、メッシュを回転させる必要があるかもしれません。

パイプラインにフィルタが幾つか追加されましたので、パイプライン・ブラウザ
でのこれらのフィルタの配置を見てみましょう。パイプライン・ブラウザによって、
今までに作成されたパイプライン・オブジェクトは判りやすいリストとなっており、
また、パイプライン・オブジェクトを選択し、それらのオブジェクトの隣にある目
のアイコン をクリックすることで表示・非表示を簡単に変更出来るようになっ
ています。しかしさらに、このリスト中の項目のインデントと、インデントを辿っ
て右側へ折れ曲がった線にも注目して下さい。これらの機能はパイプラインの連結
状態を示しています。これは右の図の従来型のグラフと同じ情報を、ずっとコンパ
クトなスペースに表しています。パイプライン・オブジェクトの従来型配置の問題
点は、多くのスペースが必要であり、さほど大規模でないパイプラインでさえ完全
に見渡すにはGUIの大部分が必要なことでした。しかし、このパイプライン・ブラ
ウザは、完全でありながらコンパクトです。
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2.5 マルチビュー
科学上の目的で時折、1つの変数に絞って検討することがあります。しかし、多く
の重要な物理現象は、互いに何らかの影響を与え合う複数の変数で記述されます。そ
れゆえ、1つの視点で多くの変数を表示するのは大変難しいといえます。ParaView

はデータを多様な視点で表示し、それらを相互に関連付ける機能を持っており、そ
のような機能は複雑な可視化データを考察する上で有用です。
今までのところ、可視化では 2つの変数に注目しています。すなわち、圧力を色
のグラデーションで表し、温度による等値面を抽出して表示しています。一見、2つ
の変数をきれいに配置できているようにも見えますが、それらを分かりやすく関連
付けることは出来ていません。複数の視点を使うことで、両者の関係を分かりやす
くすることが出来ます。各視点がデータの個別な特徴を表示し、さらにそれらを組
み合わせることで、より理解しやすい可視化を提示することができます。
各ビューの上部には小さなツールバーがあり、このツールバーの右側にビューを作
成したり、削除するためのボタンがあります。全部で 4つのボタンがあります。
もしくは ボタンを押すことで、既に有るビューをそれぞれ水平もしくは垂直に
分割して新たなビューを作成することが出来ます。 ボタンはビューを削除し、そ
のビューによって占められていたスペースは隣接するビューで占められます。 ボ
タンによって、選択したビューを一時的にビュー画面いっぱいに拡大して表示する
ことができ、 で元の状態に戻ります。ここで、 ボタンを押してください。

既存のビューが 2つに分割され、右側に空白のビューが作成されました。ここに
データを新しく可視化して表示させることが出来ます。右側のビューは、赤い線で
囲われていることに注意して下さい。これは、このビューがアクティブ・ビューで
あることを表しています。パイプライン・ブラウザやオブジェクト・インスペクタ
などの、一つのビューに関する情報を表示したり操作を行うためのウイジェット (画
面要素) は、このアクティブ・ビューに対して働きます。この新しいビューに、メッ
シュの温度分布を可視化していきます。

1. (右側の) 新しく生成した空白のビューが、赤い線で囲われていることを確認
してください。どのビューでも、ビューをクリックすることでアクティブにす
ることが出来ます。
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2. パイプライン・ブラウザ上の disk out ref.ex2の隣にある眼のマーク をク
リックして、元のデータを表示してください。

3. パイプライン・ブラウザ上で disk out ref.ex2を選択し、ツールバーで表示する
変数を Solid ColorからTempに変え、メッシュ表面を温度分布で色付けしてく
ださい (この時点で色の凡例も表示した方が良いでしょう)。

メッシュの外側に色が表示されましたが、このままでは境界面しか見ることが出来
ず、あまり興味深いものではありません。内部の温度分布を見るためにはメッシュ
を切り取る (クリップする) 必要があります。

4. disk out ref.ex2にClipフィルタ を追加します。

5. オブジェクト・インスペクタの Show Planeチェックボックス の
チェックを、はずしてください。

6. ボタンをクリックします。

画面に 2つのビューが出来ました。1つは圧力の情報を、もう 1つは温度の情報を
表示しています。これらを比較したいところですが、向きが異なるため比較は困難
です。片方の分布ともう片方の分布の関係を見るにはどうしたらいいでしょうか。カ
メラのリンクを追加し、2つのビューが常に同じ視点から描画されるようにすること
で、この問題は解決されます。カメラをリンクさせることは、とても簡単に出来ま
す。まず 1つのビュー上で右クリックし、ポップアップメニューから Link Camera...

を選択します。(もし使用しているOSがMacでマウスに右クリックがない場合、同
様の操作をメニューオプションの Tools → Add Camera Link...で行うことができま
す。)次に別のビューをクリックします。これで、2つのカメラがリンクされました。
片方を動かすと、もう一方も同じように動きます。



20 第 2 章 基本的な使用法

カメラがリンクされたことで、2つのビューを比較することが出来ます。 ボ
タンをクリックして、断面を真上から見てください。加熱されたディスクとの境界
面で、温度が最も高くなっていることが分かります。それだけでは、特筆するよう
なことではありません。空気温度は熱源近くで最大となり、離れるに従って小さく
なっていくことは予想できます。しかし圧力は、同じ地点で最大とならないことが
分かります。空気の圧力は、ディスクの上の境界面からやや離れた点で最大となっ
ています。この結果を基に、今回の物理現象について興味深い仮説を立てることが
出来ます。空気の圧力には 2つの力が作用していることが考えられます。1つ目の力
は、上方の空気が下方の空気を押さえつける働きをする、重力による作用です。2つ
目の力は、熱せられた空気の密度が小さくなり、上方に昇ろうとする浮力による作
用です。空気の圧力が最大値を取る位置から、これらの 2つの力が釣り合う点が判
ります。このように温度と圧力を同時に観察しなければ、この結論は得られません。
もちろんParaViewの複数視点の機能は、同時に 2つ以上の視点も表示できます。
各々のビューには 1セットずつ、複数視点の為の分割ボタンがあります。ビュー分
割ボタン を使うことでさらにビューを作成し、ワークスペースを分割するこ
とが出来ます。そして分割したビューは ボタンで、いつでも削除することが出来
ます。

各ビューの表示位置も固定ではありません。ビューのツールバー上 (ボタンでな
い部分) をクリックし、マウスのボタンを押したまま別のビューのツールバーの上
にドラッグすることで、2つのビューの表示位置を入れ替えることが出来ます。こ
の操作によって、2つのビューは即座に入れ替わります。
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2つのビューの間をクリックし、マウスのボタンを押したままどちらか一方のビュー
の方向にドラッグすることで、ビューのサイズを変更することも出来ます。ビューの
境界はマウスの動きに従って動き、ビューの大きさもそれに合わせて調整されます。

2.6 更なる検討
このシミュレーション結果から、他にどのような結論を導けるでしょうか。シミュ
レーションは、熱せられた回転ディスク上の空気の流れを表す速度場も算出してい
ます。ParaViewを使って、空気の流れを確認します。
既に作成した 2つのビューを残しておくために、新しいビューを作成します。
でどちらかのビューを縦に分割し、新しいビューに集中するため、新しいビューを
で最大化しておきます。パイプライン・ブラウザの disk out ref.ex2の隣にある眼の
マーク をクリックして、元のデータセットを表示します。以下の手順で空気の
流れを可視化します。

1. パイプライン・ブラウザ上で disk out ref.ex2を選択します。

2. disk out ref.ex2に流線追跡フィルタ を追加します。

3. デフォルト設定のまま、 ボタンをクリックします。

メッシュの表面に代わって、渦巻いた線が表示されます。新しい形状は、その前
の形状と中心位置が異なります。カメラのリセット コマンドを使うことで、即
座に新しい形状の中心位置に視点を合わせることが出来ます。このコマンドは、表
示されている形状を現在のビューに収め、中心を移動させると共に、回転の中心を
表示されている形状の中心に一致させます。
多くの線が互いに接するように表示され、また陰影もないため、見分け難くなっ
ています。線は 1次元の構造ですが、陰影を表現するには 2次元の面が必要です。
チューブ・フィルタを使用することで、流線の周りに 2次元の面を生成することが
できます。

4. メニューバーから、Filters → Alphabetical → Tube を選択します。
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5. ボタンを押します。

流線が鮮明に表示されるようになりました。流線を側面から見てみると、空気が
熱せられると上昇し、冷えると下降することによる円形の対流を見て取れます。流
線を回転させて、Z軸を見下ろすようにして熱せられた円盤がある筈の辺りを見る
と、回転するディスクとの摩擦によって空気が円形に流動しているのが分かります。
より高度な表示をしてみましょう。グリフを流線に追加することで、流れの方向
と大きさを表示することができます。

1. パイプライン上で StreamTracer1を選択します。

2. グリフ・フィルタ を StreamTracer1に追加します。

3. オブジェクト・インスペクタのVectorsの設定 (上から 2番目の設定) をVに変
更します。

4. オブジェクト・インスペクタの Glyph Typeの設定 (上から 3番目の設定) を
Coneに変更します。

5. ボタンを押します。

6. Temp変数によって、グリフを色付けします。
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このようにして、流線がたくさんの矢印で表示されるようになります。矢印の向
きは速度の方向を示し、大きさは速度の大きさに比例しています。この新しい表示
方法を用いて、次の問題に答えてみましょう。

• 空気の速度が最大となるのはどの地点ですか？ディスクの近く、もしくは遠く
ですか？ディスクの中央付近、それとも周縁付近ですか？

• 円盤はどちらの向きに回転していますか？

• ディスクの表面上では、空気はディスクの中心に向かって流れていますか？そ
れとも周縁部分に向かって流れていますか？

以上を完了したら、ビューのツールバーにある を押すことで、全てのビュー
を元に戻すことが出来ます。新しいビュー上で右クリックし、Link Camera...を選択
し、他の 2つのビューのどちらかとカメラをリンクさせます。これで、3つのビュー
すべてのカメラをリンクさせることが出来ました。

2.7 プロット
ParaViewのプロット機能はデータを掘り下げ、定量的な解析を可能にします。プ
ロットは基本的にフィルタによって作成されます。プロットを作成するためのフィ
ルタは、全て Filtersメニューの下のData Analysisサブメニューにあります。空間内
の線分上におけるメッシュの場の値をプロットするフィルタを作成してみましょう。

1. パイプライン・ブラウザ上の disk out ref.ex2をクリックし、アクティブな状態
にします。

2. メニューバーから Filters → Data Analysis → Plot Over Line を選択します。

アクティブなビューに、両端に球の有る直線が、表示されているデータを貫く形
で描画されます。これらの球のどちらかをマウスでドラッグすることで、3Dビュー
内を移動させることが出来ます。画面内の球を動かすたびに、オブジェクト・イン
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スペクタの項目の幾つかも変化することがわかります。目的の場所にマウスポイン
タを移動させ、pキーを押すことでも球を移動させることが出来ます。この場合、マ
ウスポインタの位置に存在する面に、球を順次移動させることになります。この方
法で球を移動させることが出来るのは、ソリッドレンダリングされた面に対しての
みであることに気をつけてください。ボリュームレンダリングに対しては、この方
法は使えません。
この表現は 3Dウィジェットと呼ばれています。なぜなら、これは 3次元空間内で
操作されるGUIコンポーネントだからです。ParaViewには、多くの 3Dウィジェッ
トの例があります。特にこのライン・ウイジェットは、空間内で線分を指定するの
に使用されます。他にも、点や面を指定するためのウィジェットがあります。

3. 線分がディスクの基部からメッシュ全体の頂部へ垂直に結ばれるように、マウ
スを使うか、pキーを押すか、もしくはオブジェクト・インスペクタで数値指
定をして調整してください。

4. 線分を目的の位置に配置できたら、 ボタンをクリックします。

プロットの際に行える操作がいくつかあります。マウスの中央ボタンをクリック
した状態で上下にドラッグすると、拡大・縮小を行う事ができます。右ボタンでド
ラッグすると、ドラッグ範囲へのズームができます。左ボタンでドラッグすると、プ
ロット画面をスクロールすることができます。 コマンドを使うことで、プロッ
トの全体像が画面に収まるようにすることも出来ます。

3Dレンダリングと同様に、プロットはビューであると考えられます。どちらも
別々の方法によってではありますが、データの表現方法を提供しています。そのた
め、3Dビューと同様の操作をプロットに対して行うことが出来ます。オブジェクト・
インスペクタのDisplayタブをみると、色、線のスタイル、ベクトル成分、凡例など、
プロットの線それぞれの表現方法に関する様々な設定があることがわかります。
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プロット・ビュー上端の ボタンによって、ラベル、凡例、軸の数値範囲など、プ
ロット全体の設定を変更するためのダイアログを呼び出すことも出来ます。

他のビューと同じように、File → Save Screenshotを選ぶことで、プロットの画
像を保存することが出来ます。さらに、プロットをレポートやその他の文書で使い
やすいように、PDFフォーマットのベクトルグラフィックスで保存することも出来
ます。他のビューと同様に、プロットを移動させることも出来ます。
こういった特徴を利用することで、プロットからより多くの情報を引き出すこと
が出来ます。例えば、プロットを使って圧力と温度の値を比較することが出来ます。

1. GUI上でプロットを移動させたい場所を選択し、分割、削除、サイズ変更、位
置の変更を使って、プロットをその場所に移動させます。

2. プロットをアクティブな状態にし、Displayタブで Tempと Pres以外の変数を
全てオフにします。

Tempと Presの変数は、異なる単位を持ちます。この 2つを同じスケールで比べ
るのは、有用ではありません。したがって、同一のプロット上で各変数を各々のス
ケールで表示し、比較することも出来ます。ParaViewの直線プロットでは、左軸と
右軸それぞれに異なったスケールを設定することができ、各変数を別々の軸にした
がってスケールさせることができます。

3. Displayタブ上で Presを選択します。
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4. Chart Axisを Bottom - Rightに変更します。

このプロットから、2.5 節で行った考察が正しいことが確認できます。温度がプ
レートの表面で最大値を取り、そこから離れるに従って下がるのに対し、圧力は少
し上昇してから下降し始めます。さらに、圧力が最大値をとるのは (そして、空気
中で力が釣り合うのは) 3単位長さだけ離れた位置であることもわかります。

ParaViewは、任意の数の異なった種類のビューに対応しています。これによって
研究者や開発者は、新しい視点でデータを見ることが出来ます。さらにもう一つの
ビューの例を示すために、パイプライン・ブラウザの disk out ref.ex2を選択し、さ
らに Filters → Data Analysis → Histogram を選択してみましょう。温度のヒスト
グラムを作成し、 ボタンを押します。

2.8 ボリューム・レンダリング
ParaViewには、データの表現方法がいくつかあります。サーフェス、ワイヤフレー
ム、およびそれらの組合せといった、いくつかの例を既に見てきました。ParaView

はさらに、データセット表面上の点、もしくは単純にバウンディング・ボックスを
表示することも出来ます。
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点 ワイヤフレーム サーフェス サーフェスと
エッジ

ボリューム

ボリューム・レンダリングは、ParaView上でデータを表現する上で強力なテク
ニックです。ボリューム・レンダリングでは、中実なメッシュが、メッシュ内の各
点における色と濃度を表すスカラー場によって、半透明の塊としてレンダリングさ
れます。サーフェス・レンダリングとは違い、ボリューム・レンダリングでは、ボ
リュームを通してデータセット内部の特徴に至るまで把握することが出来ます。
ボリューム・レンダリングは、オブジェクトの表現方法を変更することで簡単に
実現できます。温度の表示をボリューム・レンダリング表示に変えてみましょう。

1. クリップされたメッシュの表面に温度が表示されているビューを選択します。

2. 適用されているクリップ・フィルタを削除します。まず、パイプライン上でク
リップ・フィルタを選択し、 ボタンを押します。クリップされていた
メッシュの代わりに、中実なメッシュ (disk out ref.ex2) 全体が表示されます。

3. パイプライン・ブラウザ上で、disk out ref.ex2が選択されていることを確認し
てください。表示される変数をTempに、表現方法を Volumeにそれぞれ変更
します。

不透明なメッシュの代わりに、半透明なボリュームが表示されました。画像を回
転させる際に、パフォーマンスの関係でその画像が一時的に簡単な画像に置き換え
られますが、これについての詳細は後ほど記します。ParaViewのボリューム・レン
ダリングの優れた点は、他のオブジェクトのサーフェス・レンダリングと同時に使
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用できることです。これによって対象のボリューム・レンダリングの周囲の状況を
再現したり、また他の表示と組み合わせることで、より多くの情報を伝えることが
出来ます。例えば、温度のボリューム・レンダリングを流線を表示したビューと組
み合わせることが出来ます。

1. 流線を表示しているビューを選択します。

2. パイプライン・ブラウザ上の disk out ref.ex2の隣にある をクリックし、元
のデータを表示します。また disk out ref.ex2のラベルをクリックし、そのオブ
ジェクトが選択されている状態にします。

3. 表示される変数を Tempにし、表現方法を Volumeに変更します。

ボリュームを通して、温度の表示とともに流線が表示されます。
デフォルトでは、ParaViewはサーフェス・レンダリングで使われているのと同じ
色を、値の範囲の最低値を不透明度 0、最高値を不透明度 1に設定して描画します。
ParaViewでは伝達関数 (スカラー変数を表示する際の色や不透明度に関する設定)

の変更も簡単に行えます。パイプライン・ブラウザ上でボリューム・レンダリングさ
れたオブジェクトを選択した状態で、カラーマッピングの編集 ボタンをクリッ
クしてください。
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それによって現れるダイアログは、伝達関数を編集する設定を提供します。ダイ
アログ上部のグラデーションになったボックスは、色で伝達関数を、黒色の線プロッ
トで不透明度を表しています。伝達関数上の丸い点は、制御点を表しています。制
御点とは特定のスカラー値に設定された色と不透明度のことであり、制御点間の色
と不透明度は補間値が与えられます。バー上の空白部分をクリックすると、新しい
制御点が作成されます。既に有る制御点上でクリックすると、その点を選択します。
選択された制御点は、ボックスの中をドラッグしてスカラー値と透明度を変更でき、
選択された制御点上でもう 1度クリックすることで新しくダイアログボックスが表
示されます。選択された制御点は、backspaceキーもしくは deleteキーを押すと削除
されます。それではここで、制御点の作成と変更を行ってみてください。
カラーバー直下には、テキスト入力ウィジェットがあり、選択された制御点のScalar

Value (スカラー値) と Opacity (不透明度) の数値を指定できます。Scaleの設定は、
不透明度の計算における単位長を調節します。数字が大きいほど、ボリュームが透
明になります。Color Spaceの設定では、色の補間方法を変更できます。このパラ
メータは制御点の色には影響しませんが、制御点間の色には大きく影響します。Use

Logarithmic Scaleチェックボックスによって、色のスケールを対数尺度に変換するこ
とも出来ます。
伝達関数の設定は面倒になりがちですので、 ボタンをクリックするこ
とで設定を保存することが出来ます。 ボタンによって現れるダイアログ
では、作成したカラー・マップや、ParaViewに最初から用意されているカラー・マッ
プを、管理および適用することができます。ここで ボタンを押し、ダイ
アログボックス中のBlack-Body Radiationを選択して、OKをクリックしてください。
これでボリューム・レンダリングは、より熱を表現するのに相応しいようになりま
した。

ボリューム・レンダリングのカラー・マッピングのみならず、バー・チャート・
ビューによるヒストグラムを含む、全てのビューでの Tempのカラー・マッピング
が変更されていることに注意してください。これによってビュー同士の一貫性を保
証し、同じ変数を違う色や違う値の範囲でマッピングしてしまうことによる混乱を
避けることが出来ます。
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2.9 時間
ここまで disk out refのシミュレーションを余すところなく分析して来ましたの
で、次は新しいシミュレーションに進んで、ParaViewがどのように時間を扱ってい
るのかを見てみましょう。まず全てのデータを消去して、初期状態に戻りましょう。

ボタンを使用するのが一番簡単な方法です。このボタンについては後ほど詳し
く書きますが、今のところは ParaViewを再起動するのと概ね同等である、と簡単
に理解していてください。

Openから can.ex2ファイルを選択します。これは時間経過と共に変化するデータ
を持つ、簡単なシミュレーションです。

先程と同じように、変数リストの最上部のチェックボックスをクリックして、全
ての変数が読み込まれるようにし、 ボタンを押します。

ボタンを押してカメラをメッシュの方に向けます。ツールバー上の再生ボタ
ン を押して、落下するレンガが缶と衝突するメッシュをParaViewがアニメー
ションする様子を見てみましょう。

時間変化するデータを扱う際にすることは、これだけです。ParaViewには時間の
概念が組み込まれていて、データ内の時間と自動的にリンクするようになっていま
す。時間を扱うためのツールバーを理解してください。

アニメーションの保存も同様に簡単です。メニューから File → Save Animationを
選択します。ParaViewでは、ダイアログでどのようにアニメーションを保存するか
の設定ができ、そして自動的に時間を反復してアニメーションを保存します。
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ユーザーが陥る最大の落とし穴は、値の範囲が時間変化する場合の色のマッピン
グです。例を見るために、まず時間を最初の時刻ステップに設定 し、EQPS変
数をオンにし、色の凡例 をオンにします。ここで、アニメーションを最後まで
再生 して下さい (もしくは最後の段階までスキップ します)。色づけはあ
まり効果を発揮していません。ただし、データ範囲にスケールを調整する ボタ
ンを押すことで、簡単に問題は解決できます。
これは一見、欠陥のように見えますが、そうではありません。これは 2つの避け
がたい要因のためです。1つ目は、スカラー場の可視化を行うと、スケール範囲はそ
の時刻ステップでのデータの値の範囲に合わせて設定されます。理想を言えば、ス
ケールの範囲は、データの全ての時間を通しての最大値と最小値に設定されるべき
です。しかしながら、それを実現しようとすると ParaViewは最初の読み込みで全
てのデータをチェックすることになり、大規模データを処理する際にひどく動作が
遅くなってしまいます。2つ目は、時間を追ってアニメーションさせる際には、例
えデータの値の範囲が変わってもスケールの範囲は固定である必要があるからです。
アニメーションの再生に合わせて表示するスケールの範囲を変更することは、デー
タを誤って解釈する原因になります。スケールの範囲が暗黙に変動するよりは、当
初設定したとおりのカラー・マッピングの範囲から逸脱する方が断然良いでしょう。
とはいえ、代表的な時刻ステップで を押すか、カラー・スケールのダイアログ
を開き 、データの範囲を指定することで、このような問題を簡単に解消するこ
とができます。

2.10 選択機能
ParavView 3のリリースにおいて大いに進歩し、なお進化し続けている特徴は選
択機能です。選択はいつでも行うことができ、また ParaViewは現在選択されてい
る部分を、全てのビュー間で同期された形で保持しています。つまり、あるビュー
で何か選択すると、その選択範囲は同じオブジェクトを表示している全てのビュー
で表示されます。

ParaViewでは、一つのデータセットにおける点、セル、ブロックを選択すること
ができます。また、多種の IDリストアップ機能、空間中の位置指定、スカラー値の
指定などの様々な方法によって、選択範囲に含まれる要素を指定することができま
す。これから、それらの組み合わせのいくつかを見てみましょう。
選択部分を生成する最も簡単な方法は、要素をまさに 3Dビューの中から選び出
すことです。3Dビューにおける全ての選択操作は、ラバー・バンドという選択機能
によって行います。つまり、3Dビュー内でマウスをクリックしたりドラッグするこ
とで、箱状の範囲内の要素を選択することができます。ラバー・バンドによる選択
方法はいくつかの種類があり、選択設定のツールバーにあるアイコンのいずれかを
選ぶか、ショートカット・キーのいずれかによってそのうちの一つを選ぶことがで
きます。次の 3D選択方法が可能です。
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Select Cells On (Surface) (表面上のセルを選択する) ビュー内で見えるセ
ルを選択します。(ショートカットは s)

Selects Points On (Surface) (表面上の点を選択する) 視点内で見える点を
選択します。

Select Cells Through (Frustum) (表面および内部のセルを選択する) ラ
バー・バンド内に存在する全てのセルを、対象オブジェクト内部のセルも含
めて選択します。

Select Points Through (Frustum) (表面および内部の点を選択する) ラ
バー・バンド内に存在する全ての点を、対象オブジェクト内部の点も含めて
選択します。

Select Blocks (ブロックを選択する) マルチブロック・データセットから、ブ
ロックを選択します。(ショートカットは b)

sと bのショートカットによって、それぞれセルやブロックを手早く選択できま
す。マウスカーソルを選択中の 3Dビュー上のどこかに置いてから、それらのキー
を入力しましょう。そして、選択したいセルやブロックをクリックしましょう (ある
いは複数の要素上にラバー・バンドをドラッグしましょう)。
ここで選択機能を試してみて下さい。

選択要素はセレクション・インスペクタで管理できます。セレクション・インス
ペクタは View → Selection Inspectorで見ることができます。セレクション・インス
ペクタでは、選択されている全ての点やセルを見るほかにも、選択を修正すること
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もできます。またセレクション・インスペクタを使って選択要素にラベルを付加し、
要素の特定をしやすくすることができます。
セレクション・インスペクタを少し試してみましょう。Selection Inspectorを開い
てください。そしてラバー・バンドを使って選択範囲を作成し、Selection Inspector

で結果を見てみてください。また IDを変更したり、Invert Selectionのチェックボッ
クスによって選択範囲を反転して、選択範囲を変更してみてください。
すると / の表面選択ツールは点/セルのリストを表示し、 のブロック
選択ツールはブロックのリストを表示しますが、 / の内部選択ツールはど
ちらも表示していないことに気づくでしょう。これは、これらのツールが空間内の
領域を選択しているからです。選択領域を見たい場合は、Show Frustumをクリック
し、3Dビューを回転させてください。
ここで、一連の点やセルを特定する選択と、空間内の領域を特定する選択には、
根本的な違いがある事を記しておくべきでしょう。この違いを理解するには、以下
を試してください。

1. Select Cells Through ツールを使って、選択領域を生成してください。

2. Selection Inspector内の Show Frustumのチェックボックスをクリックして、3D

ビューを回転してください。

3. アニメーションを少しだけ再生 しましょう。このとき、選択領域は固定
されたまま、どのセルが領域内あるいは領域外へ移動するかによって、選択要
素が変化していることに注意して下さい。

4. Selection Typeを IDsに変更してください。

5. もう一度再生 してください。今度は、選択されたセルが位置にかかわら
ず変化しないことに注意して下さい。

スプレッドシート・ビューは選択と組み合わせて使い、分析を掘り下げるために
重要なツールです。スプレッドシート・ビューでスカラー場の実際の数値を読むこ
とができ、また選択の仕組みも活用することで目的の数値を特定しやすくなります。
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1. ビューを分割してください ( あるいは )。

2. 新しいビューにて、Spreadsheet Viewボタンをクリックしてください。

3. もし can.ex2が見えていなかったら、(対応する をクリックして) 見えるよ
うにしてください。

お分かりのとおり、スプレッドシート・ビューはかなり簡潔です。スプレッドシー
ト・ビューの上部にある２つのコンボ・ボックスについて記します。1つ目のShowing

で、表示するデータセットを (パイプライン・ブラウザを使わずに) 手早く選ぶこと
ができます。2つ目の Attributeで、異なるタイプのフィールド・データから 1つを
選び出すことができます。一度に 1種類のデータ (たとえばポイント・データまたは
セル・データ) しか表示できません。なぜなら、それぞれの種類における行の数や
列の種類は異なるからです。スプレッドシート・ビューはまた、それ自身のDisplay

パネルを持っています。

4. Attributeのコンボ・ボックスから Cell Dataを選びます。

5. スプレッドシート・ビューをスクロールして、ハイライトされた行を探しま
す。(Displayパネルにて、異なるブロックを選択しなければならないかもしれ
ません。)
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それらのハイライトされた行は、現在選択中の要素の一部です。このようなビュー
間の選択の連携は、複数のビューを関連付ける重要な仕組みです。とはいえ、この
例では、スプレッドシート・ビューにおいて選択された要素を識別するのは難しい
かもしれません。時には、選択されたデータだけを見たいこともあります。

6. Displayパネルにて、Show only selected elementsをオンにしてください。

3Dビューにおいて作成された選択に含まれる要素のみが、スプレッドシート・
ビューに現れるのが見て取れました。この関連付けは、逆向きにも働きます。すな
わち、スプレッドシート・ビューで選択を作成すると、それらは 3Dビューにも表示
されます。加えて、Selection Inspectorを使って 3Dビュー内の選択要素にラベルを
付加することもできます。

1. Show only selected elementsのチェックを外します。

2. スプレッドシート・ビューで２～３行を選択します。

3. 3Dビューで選択された結果を探します。

4. Selection Inspector内の (下部にある) Cell Labelタブをクリックします。

5. Visibleのチェックを入れます。

6. Label Modeを EQPSに変更します。

ParaViewでは、フィールド・データを時間に沿ってプロットできます。全部のデー
タを全ての時刻ステップでプロットしたいことは滅多にないでしょうから、これら
のプロットは選択部分に対して行われるようになっています。

1. 選択が有効な状態で、Plot Selection Over Timeフィルタを追加してください
(Filters → Data Analysis → Plot Selection Over Time )。

2. Object Inspector内の Copy Active Selectionをクリックします。

3. をクリックします。
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4. Displayパネルで、プロットする別のブロック (選択した要素のそれぞれと一致
します) を選択してください。

また、選択された点やセルを個別に見たり、それらについてのみ何らかの処理を
行うために、選択部分を抽出することもできます。これは Extract Selection フィ
ルタによって行われます。このフィルタを実行してみてください。

1. セルのラベル表示をオフにします。

2. 内部も含めたセルの選択 で、多めのセルを選択します。

3. Extract Selection フィルタを適用します (Filters → Data Analysis → Extract

Selection)。

4. オブジェクト・インスペクタ内の Copy Active Selectionボタンをクリックし
ます。

5. ボタンを押します。

ビュー内のオブジェクトは、先ほど選択したセルに置き換えられます。(この画像
では、抽出したセルを全体のデータと関連させて見せるために、半透明な表面と、
もとの選択部分を示すもう一つのビューを加えています。) フィルタを選択部分を
抽出したパイプライン・オブジェクトに単に付加するだけで、抽出されたセルに対
しての演算を行うことができます。
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抽出されたセルに対する操作は一通り終わったので、これらを消してしまいましょ
う (つまり、ExtractSelection1フィルタを します)。Selection Inspectorを閉
じて、プロットとスプレッドシート・ビューも削除して構いません。これでおしま
いです。また PlotSelectionOverTime1フィルタも して構いません。

2.11 時間の制御
ParaViewには、時間とアニメーションを制御する強力な設定が多数あります。こ
れらの大多数は、アニメーション・ビューを通じて利用します。メニューから、View

→ Animation Viewをクリックします。

まず、アニメーション・ビューの上部にあるウイジェットを試してみましょう。ア
ニメーションのモード設定は、ParaViewがどのように再生中に時間を進めるかを定
義します。3つのモードを利用できます。

Sequence (シーケンス) 開始、終了時刻を与えれば、アニメーションを決められた
フレーム数に等間隔に分割します。

Real Time (リアル・タイム) ParaViewは決められた秒数の再生時間となるよう、
アニメーションを再生します。実際のフレーム数は、フレーム間の更新時間に
依存します。

Snap To TimeSteps (時刻ステップにスナップする) ParaViewはデータで定義さ
れた時刻ステップどおりに再生します。

時間を含んだファイルを読込むときは常に、ParaViewは自動的にアニメーション・
モードを Snap To TimeStepsに変更します。そのためデフォルトでは、データを読
込んで、再生 を押せば、データで定義されたとおりの各時刻ステップを見る
ことができます。これが最も一般的な使い方です。
それ以外の使い方は、シミュレーションの書出したデータの時刻ステップ間隔が、
可変であるときに発生します。このような場合にはおそらく、時間のインデックス
よりも、シミュレーション上の時間に従ってアニメーションを再生したいでしょう。
問題ありません。残り 2つのアニメーション・モードのうちの 1つに切り替えられ
ます。別の使い方は、再生速度を変えたい場合です。アニメーションの速度を速く
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したり、遅くしたいことがあるでしょう。残り 2つのアニメーション・モードでは、
それができます。
やってみましょう。アニメーション・モードを、Real Timeに変更しましょう。初
期状態では、アニメーションはデータで指定されたとおりの時間の範囲となり、再
生時間は 10秒間になっています。アニメーションを再生 しましょう。結果は似
ていますが、アニメーションは、シミュレーション上の時間に比例して進行し、10

秒間で完了します。
さて、Durationを 60秒に変更してみましょう。アニメーションは明らかに、ゆっ
くりと再生されます。あなたのコンピュータでの画面更新が遅くなければ、アニメー
ションが前に比べて断続的になっていることにも気づくでしょう。これはデータセッ
トの時間解像度を上回ったからです。これは多くの場合、望ましい挙動と言えます。
データの中でまさにどれが表示されているかが分かるからです。しかし、プレゼン
テーション用にアニメーションを作りたいのなら、より滑らかなアニメーションが
求められるでしょう。

ParaViewには、これを可能にする特別なフィルタが存在します。それはテンポ
ラル・インターポレータと呼ばれています。このフィルタは、メッシュ座標等の位
置的データおよびフィールド・データに対して、元のデータセットで定義された時
刻ステップの間を補間します。この機能は、最近のParaViewとVTKパイプライン
構造の進歩によって可能になりました。このフィルタを試してみましょう。パイプ
ライン・ブラウザの can.ex2を選択してハイライト表示し、Filters → Temporal →

Temporal Interpolatorを選択しましょう。 を押して、必要ならばアニメー
ション・ビューをリアル・タイム・モードに戻しましょう。さらにビューを分割
し、一方にTemporalInterpolator1を、他方に can.ex2を表示し、カメラをリンクしま
しょう。アニメーションを再生 し、効果を見ましょう。

2.12 テキストによる注釈
ParaViewをコミュニケーションのための道具として用いるとき、作成した画像に
テキストの注釈をつけることは時に役に立ちます。ParaView 3では、3Dビューに
いつでも好きな時に注釈をつけることが非常に簡単になりました。ビュー内に単に
テキストを配置する特別なテキスト・ソースがあります。やってみましょう。

1. メニューバーから、Sources → Textを選択します。

2. オブジェクト・インスペクタのテキスト入力欄に、適当な文を入力します。

3. ボタンを押します。
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入力したテキストは、3Dビュー内に現れます。マウスでドラッグするだけで、好
きなところにこのテキストを配置できます。オブジェクト・インスペクタのDisplay

タブでは、テキストのサイズ、フォント、色の追加設定ができます。また、テキス
トを最もよく使う位置に配置するためのボタンもあります。

しばしば現在の時刻の値を、テキスト注釈に入れる必要があるでしょう。標準の
テキスト・ソースで現在の時間の値を入力するのは退屈で、間違いを起こしやすく、
さらにアニメーションを作る時は、これが不可能です。そこで、現在のアニメーショ
ンの時刻を文字列に挿入する特別なアノーテート・タイム・ソースがあります。

1. Animate Timeソース (Sources → Annotate Time) を追加します。

2. 必要ならば注釈の位置を変更します。

3. 再生 し、時刻の注釈がどう変化するか観察します。
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現在のアニメーションの時刻が、データ・ファイルから読み込まれた時刻ステッ
プと同じでない場合があります。時には、データ・ファイルに保存されている時刻
がいつであるかを知ることが重要なことがありますが、ここにフィルタとして機能
するアノーテート・タイムの特別版があります3。

1. can.ex2を選びます。

2. Filters → Alphabetical → Annotate Timeを選択します。

3. をクリックします。

4. 必要ならば注釈の位置を変更します。

5. 再生 し、時刻の注釈がどう変化するか観察します。

2.13 アニメーション
私たちは既に、時間を含むデータ・セットをアニメーションさせる方法を見てき
ました ( を押します)。しかし、ParaViewのアニメーション能力はそれ以上の
ものです。ParaViewでは、全てのパイプライン・オブジェクトのほぼ全てのプロパ
ティをアニメーションさせることができます。それを今から実行しますが、まずは
現在の ParaViewの状態を消去するために ボタンを押してください。これで単
純なアニメーションを作る準備ができました。

1. スフィア・ソース (Sources → Sphere) を生成し、 をクリックします。

2. そして、アニメーション・ビュー・パネルが可視状態である (もし可視状態で
なければ、View → Animation View) ことを確認します。

3. No. Framesの設定を 50に変更します (10では速すぎるでしょう)。

3訳注: 以下の再生時には、リアル・タイム・モードとなっていることを確認して下さい。
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4. アニメーション・ビュー下部のプロパティ選択ウィジェットで、1つ目のボッ
クスで Sphere1を、2つ目のボックスで Start Thetaを選択します。

ボタンを押します。

ここで行ったことは、Sphere1オブジェクトの Start Thetaプロパティのためのト
ラックを作成する操作です。トラックは、アニメーション・ビューでは水平なバーで表
されます。トラックには、ある特定の瞬間におけるプロパティの値を指定するキー・
フレームがあります。キー・フレーム間では、プロパティの値は補間されます。ト
ラックを生成すると、2つのキー・フレームが自動的に生成されます。1つは開始時
刻の最小値をもつキー・フレームで、もう 1つは終了時刻の最大値をもつキー・フ
レームです。ここで設定した Start Thetaプロパティは、球形状の経度方向の開始位
置を定義します。このアニメーションを再生 させると、球が展開して、ついに
は開ききって消滅するのが見られるでしょう。

トラックはその上でダブルクリックすることで、修正できます。ダブルクリック
すると、キー・フレームを追加、削除および修正するのに使えるダイアログ・ボッ
クスが表示されます。

この機能を、アニメーションに新たなキー・フレームを追加するのに使います。
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5. Sphere1 – Start Thetaトラックをダブルクリックします。

6. Animation Keyframesダイアログ内のNewボタンをクリックします。これで時
刻 0.5のところに新たなキー・フレームが作成されます。

7. 1番目のキー・フレームの値を 360に、2番目のキー・フレームの値を 0に修
正します。

8. OKをクリックします。

アニメーションを再生すると、球ははじめ大きくなり、その後また小さくなります。
アニメーションさせられるのは 1つのプロパティに限定されません。いくつのプ
ロパティでも、必要なだけアニメーションできます。ここでは、2つのプロパティを
変更するアニメーションを作ってみましょう。

1. Sphere1 – Start Thetaトラックをダブルクリックします。

2. Animation Keyframesダイアログ内で、(時刻ステップ 0の) 最初のトラックを
Deleteします。

3. アニメーション・ビューで、Sphere1オブジェクトの End Thetaプロパティの
トラックを作成します。

4. OKをクリックします。

5. Sphere1 – End Thetaのトラックをダブルクリックします。

6. 2番目のキー・フレームの時刻を 0.5に変更します。

このアニメーションでは、球が生成・消滅するのが見られますが、今回は球形状
の描画範囲の変化部分が同じ方向に回転しています。それによって、このアニメー
ションをループ させたときに、とても満足のいくアニメーションとなってい
ます。
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2.14 スクリプティング
ParaView の設定を変更し、自動化する方法は多数あります。そのため
の最も便利な方法の一つは、ParaView に内蔵された Python スクリプテ
ィングの機能を利用することです。Python バインディングはこのチュー
トリアルの範囲を超えますが、それを利用するための方法を述べておき
ます。Python バインディングに関するさらなる情報は、ParaView Wiki

(http://www.paraview.org/Wiki/images/2/26/Servermanager.pdf) から得るこ
とができます。

ParaViewから Pythonを使用する最も簡単な方法は、内蔵の Pythonシェルを起
動する方法です。メニューから、Tools → Python Shellを選択して下さい。これに
よってPythonシェルのダイアログ・ボックスが現れ、前もって用意したスクリプト
を実行したり、保存されたステートを読込んだり、パイプライン・オブジェクトを
操作したり、プラグインを読込んだり、といった様々なコマンドを実行することが
できます。

パイプライン内からデータを操作するために、Pythonを使用する方法もありま
す。プログラマブル・フィルタ (Filters → Data Analysis → Programmable Filterに
よって選択) と呼ばれる、特別なフィルタがあります。このフィルタによって、オブ
ジェクト・インスペクタからPythonスクリプトを入力することができます。このス
クリプトは、パイプラインがアップデートされる度に実行されます。スクリプトか
らはデータに直接アクセスすることが可能で、そのデータをどのようにでも操作す
ることができます。プログラマブル・フィルタの真に素晴らしい点は、並列モード
でも動作することです。データが分散並列マシン上に存在する場合には、Pythonス
クリプトもまたそれらのマシン上に分散され、シリアルに実行されているのと同じ
ようにそれらのデータに対して実行されます。したがって、ユーザの側で特段の配
慮をすることなく、それらのデータに対する並列スクリプティングを行うことがで
きます。
ときには、ParaViewのGUIを全く使用せずに (したがって、ユーザが介入するこ
となく)　Pythonスクリプトによってポストプロセッシングおよび可視化を自動化
することが便利なことがあります。これは、ParaViewに付属する pvpythonアプリ
ケーションによって可能です。pvpythonアプリケーションは単に、ParaViewバイ

http://www.paraview.org/Wiki/images/2/26/Servermanager.pdf
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ンディングを既に読込んだ状態のPythonインタプリタです。このプログラムをスク
リプトと共に実行して、ParaViewを完全に自動化することができます。ParaView

には、pvbatchと呼ばれる、似たようなプログラムも付属します。pvpythonと異な
り、pvbatchはクライアント／サーバ接続を確立すること無く並列に実行すること
が可能ですが、GUIライブラリの幾つかは利用できません。
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サンディア国立研究所では、ここに示した例のようなRed Stormスーパーコンピ
ュータで実行された大規模シミュレーションのデータを可視化するために、ParaView

を頻繁に使用しています。左上の画像は、ゴレブカ小惑星の中心で起爆した 10メガ
トン爆発の、10億セル以上の規模でのCTHによる衝撃波シミュレーションです。右
上の画像は、高緯度で極大気を捕捉する極周囲のジェット気流である極渦の崩壊の、
10億セル以上の規模でのSEAM気候モデルシミュレーションです。左下は、横風火災
における物体の、1000万の非構造 6面体格子による SIERRA/Fuego/Syrinx/Calore

を用いた弱連成シミュレーションです。右下は、AMRデータを生成するCTHによ
るシミュレーションです。ParaViewは、数十億セル、数十万ブロック、そして 11レ
ベルの階層構造からなるCTHのシミュレーションによるAMRデータの可視化に使
用されてきました (ここでは示しませんが)。
本節では、ParaViewの並列可視化機能を用いて、このような大規模メッシュを可
視化する方法を解説します。本節は前節ほど実践的ではありません。その代わり、大
規模な並列可視化を行うための概念的な知識を学んで頂くことになります。ここで
は基本的な ParaViewの構造および並列アルゴリズムを示し、これらの知識をどの
ように利用するかを実演します。
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3.1 ParaViewの構造
ParaViewは 3層のクライアント・サーバ構造になっています。ParaViewにおけ
るそれら 3つの論理的なユニットは、以下のとおりです。

データ・サーバ データの読込み、フィルタリング、書出しを担当するユニットです。
パイプライン・ブラウザに表示される全てのパイプライン・オブジェクトは、
データ・サーバが保持しています。データ・サーバは並列実行が可能です。

レンダー・サーバ レンダリングを担当するユニットです。レンダー・サーバも並列
実行が可能で、その場合は内蔵の並列レンダリング機能が有効化されます。

クライアント 可視化の作成を担当するユニットです。クライアントはサーバにおけ
るオブジェクトの作成、実行、削除を制御しますが、実際のデータは全く保持
しません (そのため、クライアントがボトルネックとなることが無く、サーバ
が大規模データへとスケーリングすることができます)。GUIもまた、クライ
アントに含まれます。クライアントは常にシリアルに実行される、非並列化ア
プリケーションです。

これらの論理ユニットは、物理的に分割されている必要はありません。論理ユニッ
トは多くの場合、同一のアプリケーションに含まれ、それらのユニット間での通信
を不要としています。ParaViewは、以下の 3つのモードで実行されます。

最初のモードはスタンドアローン・モードで、既に使用してきたとおりのモード
です。スタンドアローン・モードでは、クライアント、データ・サーバ、レンダー・
サーバは全て一つのシリアル実行アプリケーションに統合されています。paraview

アプリケーションを実行すると、ParaViewの全ての機能をすぐに使えるよう、ビル
トイン・サーバに接続されています。
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2つ目のモードはクライアント－サーバ・モードです。クライアント－サーバ・
モードでは、pvserverプログラムを並列マシン上で実行し、それに paraviewクラ
イアント・アプリケーションを接続します。pvserverプログラムはデータ・サーバ
とレンダー・サーバの両方を含んでおり、したがってデータ処理とレンダリングの
両方が pvserverで実行されます。クライアントとサーバはソケットを通じて接続
します。ソケット通信は比較的低速な通信手法であるため、このソケットを通じた
データ転送量は最小に抑えられています。

3つ目のモードは、クライアント－レンダー・サーバ－データ・サーバ・モードで
す。このモードでは、全ての 3つの論理ユニットが個別のプログラムとして実行さ
れます。クライアント－サーバ・モードと同様、クライアントはレンダー・サーバ
に 1つのソケットによって接続されます。レンダー・サーバとデータ・サーバはレ
ンダー・サーバのプロセスそれぞれにつき 1つづつ、多数のソケットによって接続
されます。ソケットを通じたデータ転送量は最小に抑えられています。
クライアント－レンダー・サーバ－データ・サーバ・モードはサポートされては
いますが、このモードはまず推奨されません。このモードの元々の意図は、大規模
でパワフルな計算プラットフォームと、小規模なグラフィックス・ハードウエアが
内蔵された並列マシンからなる異種混在環境を活用することでした。しかしながら
実際には、データ・サーバからレンダー・サーバへの転送所要時間によって、あら
ゆる利点が相殺されてしまうことが判りました。もし計算プラットフォームのほう
がグラフィックス・クラスタより非常に大きい場合は、ソフトウエア・レンダリン
グを使用して下さい。もし両プラットフォームが概ね同じ規模である場合は、グラ
フィックス・クラスタで全ての処理を実行して下さい。

3.2 ParaViewサーバのセットアップ
スタンドアローンのParaViewをセットアップするのは通常、難しくありません。
コンパイル済みのバイナリをダウンロードし、コンピュータにインストールすれば、
すぐに実行可能です。しかしながら、ParaViewサーバのセットアップはどうしても、
それよりは難しくなります。まず、サーバを自前でコンパイルしなければなりませ
ん。並列プログラミングのためのライブラリであるMPIには様々な種類のものがあ
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り、さらに個々のMPIは並列コンピュータの通信ハードウエアに合わせて変更が可
能であるため、全ての考えうる組合せについて信頼できるバイナリファイルを提供
するのは不可能です。

ParaViewを並列マシンでコンパイルするには、以下が必要です。

• CMake クロスプラットフォーム・ビルディング・ツール (www.cmake.org)

• MPI

• OpenGL (または、他に利用可能なものが無ければMesa 3D www.mesa3d.org)

• Qt 4.3 (オプション)

• Python (オプション)

オプションのライブラリ無しでコンパイルした場合は、それに対応する機能を利
用できなくなります。Qt無しでコンパイルした場合は、GUIアプリケーションを利
用できません。Python無しでコンパイルした場合は、スクリプト機能を利用できま
せん。

ParaViewをコンパイルするには、まずCMakeを実行し、コンパイルのための設
定とシステム上のライブラリの指定を行います。これによってMakefileが生成され、
そのMakefileを使用してParaViewをビルドします。ParaViewサーバのビルドに関
するさらなる詳細については、ParaView Wikiをご覧下さい。

http://www.paraview.org/Wiki/Setting up a ParaView Server#Compiling

ParaViewを並列に実行するのもまた、必然的にスタンドアローンのクライアント
を実行するより難しくなります。リモート・コンピュータにログインし、並列ノー
ドを確保し、並列プログラムを起動し、接続を確立し、ファイアウオールのトンネ
リングを行うといった、実行環境に依存する幾つもの段階を経る必要があります。
クライアント－サーバ間接続は、paraviewクライアント・アプリケーションに
よって確立されます。サーバに接続し、またサーバへの接続を解除するには、 お
よび ボタンを使用します。ParaViewの起動時には、ビルトイン・サーバという
特別なサーバに自動的に接続されます。また、サーバへの接続が解除された時にも、
常にビルトイン・サーバに接続されます。それら両者の例は、既に見たとおりです。

ボタンをクリックすると、接続可能な既知のサーバのリストを含んだダイア
ログが現れます。このサーバのリストはサイト、またはユーザごとに設定できます。

http://www.cmake.org
http://www.mesa3d.org
http://www.paraview.org/Wiki/Setting_up_a_ParaView_Server#Compiling


3.3. 並列可視化アルゴリズム 49

どのようにしてサーバに接続するかは、Add ServerボタンをクリックしてGUIで
設定するか、または XMLの設定ファイルによって設定することができます。サー
バ接続を指定するための方法は幾つかありますが、最終的にはサーバを起動するた
めのコマンドと、サーバの起動後に接続するためのホスト名を設定することになり
ます。サーバ接続の確立に関するさらなる詳細については、ParaView Wikiをご覧
下さい。

http://www.paraview.org/Wiki/Setting up a ParaView Server#Running the Server

3.3 並列可視化アルゴリズム
ひとたび並列化のフレームワークさえ作成すれば、並列可視化を行うのは単純で
ある点で、私たちは幸運といえます。データはメッシュに含まれていますから、そ
れはすなわち、既にデータがセルによって細かな断片に細分化されていることにな
ります。それらのセルをプロセスごとに分割することで、分散並列マシン上で可視
化を行うことができます。具体的に示すため、以下の非常に簡略化されたメッシュ
を考えます。

このメッシュについて、3つのプロセスを使用して可視化を行いたいとします。以
下に青、黄、ピンク色の領域で示すように、このメッシュのセルを分割します。

http://www.paraview.org/Wiki/Setting_up_a_ParaView_Server#Running_the_Server
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ひとたび分割されれば、幾つかの可視化アルゴリズムは、それぞれのプロセスに
おいてローカルに保持されるセルに対してアルゴリズムを独立に実行することで、
処理することができます。クリッピングを例にしましょう。クリッピングを行う切
断面を定義し、この切断面をそれぞれのプロセスに与えます。

それぞれのプロセスは、この切断面によって独立にクリッピングを行うことがで
きます。最終的に得られる結果は、このクリッピングをシリアルに実行した場合と
同じです。(大規模データでは明らかに、絶対に行うべきではありませんが) これら
のセルをもし、再び結合したとすれば、クリッピング演算が正しく行われたことが
わかります。

3.4 ゴースト・レベル
しかしながら残念なことに、可視化アルゴリズムを分割されたセルに対して闇雲
に実行しても、必ず答えが正しいとはとは限りません。簡単な例として、外部界面ア
ルゴリズムを考えて下さい。外部界面アルゴリズムとは、1つのセルにのみ属する
セル界面のすべてを探索する、すなわちメッシュの境界面を特定するアルゴリズム
です。
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おっと。全てのプロセスが外部界面アルゴリズムを個別に実行すると、多くの内
部界面が外部界面として誤って特定されるのが判ります。これは、あるパーティショ
ンのセルが別のパーティションのセルに隣接するところで起こります。プロセスが
別のパーティションのセルにアクセスする方法がありませんので、これらの隣接セ
ルが存在することを知る方法はありません。

ParaViewや、その他の並列可視化システムで採用されている解決法は、ゴース
ト・セルの利用です。ゴースト・セルとは、あるプロセスによって保持されていま
すが、実際には別のプロセスに属するセルのことです。ゴースト・セルを使用する
には、それぞれのパーティションにおける全ての隣接セルを特定しなければなりま
せん。そして、それらの隣接セルをそのパーティションにコピーし、コピーされた
セルをゴースト・セルとして、以下の例では灰色のセルで示されるようにマークし
ます。

外部界面アルゴリズムをゴースト・セルに対して実行すると、それでもなお幾つ
かの内部界面を外部として誤って特定しているのが判ります。しかしながら、これ
らの全ての誤って特定された界面はゴースト・セルに属しており、したがってそれ
らの界面は属するセルの「ゴーストである」との状態を継承しています。それらの
「ゴーストな」界面は ParaViewによって取り除かれ、正しい解に辿り着きます。
この例では 1層のゴースト・セル、すなわちパーティション内のセルに直接隣接す
るセルのみを示しました。ParaViewでは、複数の層からなるゴースト・セルを取出
すことが可能です。すなわち、それぞれの層が、下のゴースト層あるいは元のデー
タそのものに含まれていない一つ下の層の隣接セルを含んでいます。これは、それ
ぞれがゴースト・セルの層を必要とするようなフィルタを直列に使用する際に便利
です。それらのフィルタは、それぞれ上流側に対して追加のゴースト・セルの層を
要求し、下流側へデータを送る際に 1層だけ取り除きます。

3.5 データの分割
ここではデータを分割して分散させるため、データの分割法の影響に関して議論
しておくこととします。前述の例で示されたデータは空間的にコヒーレントな分割
法と言えます。すなわち、各パーティションのセルは全て空間中のコンパクトな領
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域に存在しています。その他にもデータを分割する方法は存在します。例えば、ラ
ンダムに分割する方法も有り得ます。

ランダム分割には、良い面があります。というのも、パーティションの作成およ
び負荷分散が容易であるからです。しかしながら、ゴースト・セルに関しては、深
刻な問題が存在します。

この例では、1層のゴースト・セルによって、全プロセスにおいてデータセット
のほぼ全体が複製されてしまっていることが判ります。したがって、並列処理の利
点がほぼ失われてしまっています。ParaViewにおいてゴースト・セルは頻繁に使用
されるため、ParaViewではランダム分割は使用されていません。

3.6 D3フィルタ
前節では、並列可視化のための負荷分散およびゴースト・セルの重要性を述べま
した。本節では、負荷分散のための方法を述べます。
負荷分散およびゴースト・セルは、構造データ (画像データ、直線格子、および構
造格子) を読み込んだ際には、ParaViewによって自動的に取扱われます。構造デー
タが暗黙に有するトポロジのために、データを空間的にコヒーレントなパーティショ
ンに分割し、隣接セルの位置を特定するのが容易であるためです。
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ところが、非構造格子 (ポリ・データおよび非構造格子) を読み込む際には、全く
異なった状況になります。非構造格子には、暗黙のトポロジや隣接セルの情報があ
りません。このときの ParaViewの動作は、どのようにデータがディスクに書かれ
たかに依存します。したがって、非構造格子が読み込まれる際には、そのデータが
どの程度良好に負荷分散されるかについては保証されません。さらに、そのような
データがゴースト・セルの情報を含んでいる可能性は低いため、幾つかのフィルタ
の出力は正しくない可能性があります。
幸い ParaViewには、非構造格子の負荷分散を行って、ゴースト・セルを作成す
るためのフィルタがあります。このフィルタは、distributed data decomposition (分
散データ分割) の頭文字をとってD3と呼ばれます。D3フィルタの使用法は簡単で、
(Filters → Alphabetical → D3に存在する) このフィルタを、分割し直したいデータ
に適用するだけです。

D3の最も一般的な使い方は、非構造格子データ読み込みモジュールに対して直接
適用する方法です。読み込まれたデータが如何にうまく負荷分散されていても、以
降のフィルタが正しいデータを生成するよう、ゴースト・セルを抽出することは重
要です。上記の例は、ある非構造格子へ表面抽出フィルタを適用した結果の断面で
す。左図ではゴースト・セルが無いために、多くの界面が誤って抽出されているこ
とが判ります。一方で右図では、D3フィルタをまず最初に適用することで、その不
具合が修正されています。

3.7 ジョブ・サイズにデータ・サイズを合わせる
ParaViewサーバとして、幾つのプロセスを使用すべきでしょうか。これは多くの
重要な影響を含む、普遍的な質問と言えます。そしてまた、非常に難しい質問でも
あります。それぞれのプロセスにどのようなハードウエアが対応付けられているか、
どの程度の大きさのデータを処理しようとしているか、どのような型のデータを処
理しようとしているか、どのような種類の可視化操作を行おうとしているか、そし
てユーザ自身の我慢強さなどの要因によって、その回答は大きく左右されます。
したがって、確固たる回答はありません。しかしながら、幾つかの経験則はあり
ます。
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構造データ (画像データ、直線格子、構造格子) に対しては、少なくとも 2,000万
セルにつき 1つのプロセッサが与えられるようにしてください。もしさらにプロセッ
サを割り当てられるなら、500から 1,000万セルにつき 1プロセッサが与えられれ
ば、通常は充分です。
非構造データ (ポリ・データ、非構造格子) に対しては、少なくとも 100万セルに
対し 1プロセッサが与えられるようにしてください。もしさらにプロセッサを割り
当てられるなら、25万から 50万セルにつき 1プロセッサが与えられれば、通常は充
分です。
前述のように、これらは経験則に過ぎず、絶対的法則ではありません。常にデータ
量に対してどの程度のプロセッサが適切かを評価し、実験するように努めるべきで
す。そしてもちろん、読み込みたいデータの規模が、ユーザが利用可能な計算機資源
の限界を拡大する時が来る可能性は、常にあります。このような状況になれば、デー
タ量の爆発的増大を確実に回避し、データを確実に間引きたくなることでしょう。

3.8 データ量の爆発的増大の回避
ParaViewの有するパイプライン・モデルは、試行錯誤による可視化にはとても便
利です。コンポーネント間の連携が緩やかであるため、型どおりでない可視化の構
築のためのとても柔軟なフレームワークとなっています。また、パイプライン構造
のため、設定を素早く容易に追い込むことが出来るようになっています。
この連携方法の欠点は、メモリ使用量が比較的多くなることです。パイプライン
の各段階でそれぞれがデータを重複して保持するためです。ParaViewは可能な時
は常に、パイプラインの各段階がメモリ内の同一の領域のデータを参照するよう、
データの浅いコピーを行います。しかしながら、新たなデータを作成したり、デー
タの値やトポロジを変更するようなフィルタは全て、それらの結果のための新たな
メモリを確保せざるを得ません。ParaViewが非常に大きなメッシュに対してフィル
タを適用する場合には、フィルタの使用法が適切でなければ即座に利用可能なメモ
リを全て使い尽くしてしまいます。したがって、大規模なデータセットを可視化す
る際には、フィルタのメモリ所要量を理解しておくことが重要です。
ただし、以下の助言は非常に大規模なデータを取扱っていながら、使用可能なメ
モリが少なくなっている時のためのみであることに注意してください。メモリが尽
きる心配がなければ、以下の助言は全て無視してください。
構造データを扱っているときは、どのフィルタがデータを非構造データに変更す
るかを知っておくことは絶対的に重要です。なぜなら、非構造データは、トポロジを
明示的に記述する必要があるため、構造データよりもセルあたりのメモリ使用量が
大幅に増大するからです。ParaViewには、トポロジを何らかの方法で変更するフィ
ルタが数多く存在し、それらのフィルタは生成されるあらゆる種類のトポロジを扱
えるデータセットが非構造データのみであるため、データを非構造格子として書き
出します。以下にリストされたフィルタは、入力とおおむね等しい新たな非構造格
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子トポロジを出力に書き出します。これらのフィルタは、絶対に構造データに対し
ては使用するべきではなく、非構造データに対してのみ注意しながら使用するべき
です。

• Append Datasets

• Append Geometry

• Clean

• Clean to Grid

• Connectivity

• D3

• Delaunay 2D/3D

• Extract Edges

• Linear Extrusion

• Loop Subdivision

• Reflect

• Rotational Extrusion

• Shrink

• Smooth

• Subdivide

• Tessellate

• Tetrahedralize

• Triangle Strips

• Triangulate

技術的には、Ribbonおよび Tubeフィルタもこのリストに含まれます。しかしな
がら、それらはポリ・データ中の 1次元のセルにのみ作用するため、入力データは
通常小規模で、ほとんど影響はありません。
次の同様な一連のフィルタもまた、非構造格子を出力しますが、一般的にはその
データ量 (格子数) をいくらか削減します。ただし、このデータ量削減は多くの場
合、非構造格子への変換によるオーバーヘッドを補う程ではないことに注意して下
さい。また多くの場合、このデータ量の削減は (負荷分散の点では) あまり上手くバ
ランスしないことに注意して下さい。したがって、これらのフィルタは非構造デー
タに対しては注意深く、また構造データに対しては非常に注意深く使用する必要が
あります。

• Clip

• Decimate

• Extract Cells by Region

• Extract Selection

• Quadric Clustering

• Threshold

上のリストの項目と同様に、Extract Subset は構造データセットに対してデー
タ量削減を行いますが、構造データを出力します。したがって、新たなデータが作成
されるという注意点は同様ですが、非構造データに変換されるとの心配は不要です。
以下の一連のフィルタもまた非構造データを出力しますが、(3次元から 2次元へ
のような) データの次元の削減を行いますので、出力はずっと小さくなります。し
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たがって、これらのフィルタは通常、非構造データに対しても使用することができ、
構造データに対しても多少の注意を払えば充分です。

• Cell Centers

• Contour

• Extract CTH Fragments

• Extract CTH Parts

• Extract Surface

• Feature Edges

• Mask Points

• Outline (curvilinear)

• Slice

• Stream Tracer

これらのフィルタはデータのコネクティビティを全く変更しません。そのかわり、
データにフィールド配列のみを付加します。既に存在するデータに対しては浅いコ
ピーが行われます。これらのフィルタは通常、どのようなデータに対しても使用す
ることができます。

• Block Scalars

• Calculator

• Cell Data to Point Data

• Curvature

• Elevation

• Generate Surface Normals

• Gradient

• Level Scalars

• Median

• Mesh Quality

• Octree Depth Limit

• Octree Depth Scalars

• Point Data to Cell Data

• Process Id Scalars

• Random Vectors

• Resample with dataset

• Surface Flow

• Surface Vectors

• Texture Map to...

• Transform

• Warp (scalar)

• Warp (vector)

以下の最後の一連のフィルタは、データを出力に全く追加しない (全ての出力デー
タは浅いコピーによって得られる) か、付加されるデータは入力データの量に依存
しないフィルタです。これらはどんな状況でも、まず問題なく使用することができ
ます (ただし、処理時間は要するかもしれません)。
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• Annotate Time

• Append Attributes

• Extract Block

• Extract Datasets

• Extract Level

• Glyph

• Group Datasets

• Histogram

• Integrate Variables

• Normal Glyphs

• Outline

• Outline Corners

• Plot Global Variables Over Time

• Plot Over Line

• Plot Selection Over Time

• Probe Location

• Temporal Shift Scale

• Temporal Snap-to-Time-Steps

• Temporal Statistics

上記の分類には上手くあてはまらない、特殊なフィルタも存在します。それらの
フィルタの幾つか (今のところ Temporal Interpolatorと Particle Tracer) は、データ
が時間によってどのように変化するかに基づいて処理を行います。したがって、こ
れらのフィルタは 2ステップ、またはそれ以上の時刻ステップを読込む必要があり、
メモリ上で必要なデータの量が倍、またはそれ以上となる可能性があります。また、
時間軸方向の処理を行うフィルタの幾つか、例えば Temporal Statisticsや、時間軸
に沿ってデータをプロットするようなフィルタは、全てのデータをディスクから反
復的に読込む必要があります。したがって、たとえ余分なメモリを使用しなくても、
非実用的なほど長い処理時間を要する可能性があります。

Programmable Filter もまた、分類が不可能な特殊なケースです。このフィル
タはプログラミングされたとおりの処理を行いますので、これらの分類のいずれに
もあてはまる可能性があります。

3.9 データを間引く
大規模なデータを扱う際には、可能な限りデータを間引くことが明らかに最良の
策であり、それも早い段階で行うほど、良いといえます。ほとんどの大規模データ
は 3次元の形状として読込まれますが、所要の形状はそのデータの (表面などの) 面
であることがしばしばあります。面データの所要メモリは通常、その元となる立体
データよりも大幅に小さいため、早い段階で面データに変換するのが最良といえま
す。ひとたびそのようにすれば、他のフィルタを比較的安全に適用することができ
ます。
非常に一般的な可視化の操作としては、Contour フィルタを使用して立体デー
タから等値面を抽出することが挙げられます。Contourフィルタは通常、入力より
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ずっと小さなデータ量の形状を出力します。したがって、いかなる状況であれ、も
し Contourフィルタを使用するのであれば、早い段階で適用するべきです。とはい
え、Contourフィルタは大量のデータを生成する可能性もありますので、設定には
注意して下さい。大量の等値面を生成する値を指定すれば、当然ながらそのような
状況は起こり得ます。データ中の等値面を生成する値の上下に、ノイズのような高
周波の変動が存在すれば、それも大量の不整形な面を生成する原因となります。
立体データの内部を見るもう一つの方法は、Slice フィルタを適用すること
です。Slice フィルタは、立体データを面によって薄切りにして、立体内の面が
切断する部分のデータを見えるようにします。もし大規模データの中で興味深い特
徴を有する位置が既に判っていれば、薄切りにするのがそのデータを見る良い方法
です。
もしもデータについてあらかじめ与えられた情報がほとんどなく、しかも全デー
タセットに対するメモリ量や処理時間を必要とすることなくデータを調べたいので
あれば、Extract Subset フィルタを使用してデータの一部の領域を抽出、およ
び間引くことができます。間引かれたデータの量を元のデータよりも大幅に小さく
することは可能でありながら、間引かれたデータは良好に負荷分散されているはず
です。もちろん、間引くことによって細かなデータの変化は失われる可能性があり、
必要なデータの特徴を発見したら完全なデータセットに戻って可視化を行うべきで
あることは注意して下さい。
立体データの一部を取り出すことのできるフィルタは幾つかあります。Clip 、

Threshold 、Extract Selection、そして Extract Subset はいずれも、何らか
の基準によってセルを抽出することができます。しかしながら、抽出されたセルが
上手く負荷分散されている可能性はほとんど無く、全くセルが取り除かれないプロ
セスも存在する可能性に注意して下さい。また、Extract Subset 以外のこれら
のフィルタは全て、構造データ型を非構造格子に変換します。したがってこれらは、
抽出されたセルが元のデータより少なくとも一桁以上少なくなるのでない限り、使
用するべきではありません。
可能であれば、3次元データを抽出するフィルタを 2次元の面を抽出するフィル
タで置き換えてみて下さい。例えば、データ中のある平面を調べたいのであれば、
Clip フィルタよりも Slice フィルタを使用して下さい。もしある範囲内の
値を含むセルの領域の位置を調べるのであれば、Threshold フィルタを使って
全てのセルを抽出するよりも、Contour フィルタを使ってその範囲の両端とな
る等値面を生成するようにしてみてください。ただし、このように代わりのフィル
タを使用すると、下流側のフィルタに影響する可能性があることに注意して下さい。
例えば、Threshold フィルタの後にHistogram フィルタを実行するのは、ほ
ぼ同等のContour フィルタの後に実行するのとは全く異なった結果となります。
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3.10 レンダリング
レンダリングとは、データから実際に目にする画像を生成する処理のことです。
データと効率的にインタラクションする能力は、レンダリングのスピードに大きく
依存します。コンピュータ・ゲーム市場に牽引された 3次元処理のハードウエア・ア
クセラレーションの進歩によって、高価でないコンピュータでさえ、3次元画像を
高速にレンダリングできるようになりました。しかしながらもちろん、レンダリン
グの速度はレンダリングされるデータの量に比例します。データが大きくなるほど、
レンダリング処理は必然的に遅くなります。
可視化セッションが確実にインタラクティブに実行されるため、ParaViewは 2つ
のモードをサポートしており、それらのモードは必要に応じて自動的に切り替えら
れます。スティル・レンダーと呼ばれる 1つ目のモードでは、データは可能な限りの
ディテールを保持してレンダリングされます。このレンダリング・モードでは、確
実にデータの全てが正確に表現されます。インタラクティブ・レンダーと呼ばれる 2

つ目のモードでは、正確さよりも速度が優先されます。このレンダリング・モード
では、データの大きさにかかわらず、高速なレンダリングが行われるよう配慮され
ます。
マウスによる回転、パン、ズームなどの、3Dビューにおけるインタラクションを
行っている間は、ParaViewはインタラクティブ・レンダーを行います。これはイン
タラクションの間、これらの機能を実用的に保つため、高いフレームレートが必要
であるのと、インタラクションの間それぞれのフレームはすぐに次のフレームで置
き換えられるため、このモードにおいては精細なディテールはあまり重要でないた
めです。3Dビューにおけるインタラクションが行われていない時は、ParaViewは
データの全てのディテールが明らかになるよう、スティル・レンダーを使用します。
3Dビューでマウスをドラッグしてデータを動かすと、マウスを動かしている間は概
略のみがレンダリングされますが、マウスボタンを放すとすぐに完全なディテール
まで表現されるのがお判り頂けるでしょう。
インタラクティブ・レンダーは速度と正確さの妥協の産物です。したがって、いつ、
どのように粗いディテールが使用されるかについては、多くの設定が関係します。

3.10.1 基本的な設定
最も重要なレンダリング設定の幾つかは、LODに関する設定です。インタラク
ティブなレンダリングの間、形状は低いディテールのレベル(LOD)、すなわちより
少ないポリゴンで表現された近似的な形状に置き換えられることがあります。
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形状の近似化の解像度は、変更することができます。形状簡略化のアルゴリズム
は、ポリゴンを粗い格子に沿って配置するように動作します。上の画像では、左の
画像は完全な解像度です。中央の画像は 503分割の格子による形状簡略化の結果で、
右の画像は 103分割の格子による形状簡略化の結果です。

3次元レンダリングの設定は、メニューの Edit → Settings (Macでは ParaView →

Preferences) で現れる設定ダイアログボックスにあります。ダイアログを開くと、基
本的なレンダリング設定は Render View → General以下にあります。

レンダリング性能に関する設定は、以下のような意味があります。

Use Immediate Mode Rendering (イミディエイト・モード・レンダリングを使用する)

これをチェックすると、形状はグラフィックス・カードに送られてイミディエ
イト・レンダリングが行われます。チェックを外すと、形状はより効率的なレ
ンダリングのためにディスプレイ・リストにまとめられます。通常はディス
プレイ・リストの方が高速にレンダリングされますが、最初のフレームのレ
ンダリングの間にディスプレイ・リストを作成する時間、およびそれを保持
するメモリが必要となります。

Use Triangle Strips (トライアングル・ストリップを使用する) チェックを外す
と、データはポリ・データによって定義されたとおりにレンダリングされます。
チェックすると、データはトライアングル・ストリップに変換されます。トラ
イアングル・ストリップはグラフィックス・カードに効率的に転送され、より
高速にレンダリングされることもありますが、通常はそうではありません。
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LOD Threshold (LODしきい値) どのような時に形状を簡略化された形状で置き
換えるかを制御します。チェックボックスは、この機能自体をオンまたはオフ
にします。オンの場合は、スライダによってこの機能の動作するしきい値を与
えます。形状のデータ量がこのしきい値未満であれば、その形状はレンダリン
グするのに充分小さいと見なされます。形状のデータ量がこのしきい値より大
きければ、簡略化された形状がレンダリングに使用されます。

Allow Rendering Interrupts (レンダリングの中断を許可する) チェックされて
いる場合、スティル・レンダーを中断してインタラクティブ・レンダーを行
えるようになります。

3.10.2 基本的な並列レンダリング
並列可視化を行う際には、レンダリングに至るまで、およびレンダリング自体の全
てのプロセスにおいて、データが分割されているよう注意します。ParaViewでは、
IceTと呼ばれる並列レンダリング・ライブラリが使用されます。IceTでは、ソー
ト・ラスト・アルゴリズムが、並列レンダリングに使用されます。この並列レンダ
リング・アルゴリズムによって、それぞれのプロセスはそれぞれに与えられた分割
された形状を独立にレンダリングし、その結果の部分的な画像を重畳して最終的な
画像を生成することができます。

上の図は大幅に簡略化したものです。IceTには、2分木法やバイナリ・スワップ
法のような、いくつかの段階を用いて処理を効率的にプロセス間に分割する、複数
の並列化された画像重畳アルゴリズムが含まれています。
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ソート・ラスト法による並列レンダリングの素晴らしい点は、その効率がレンダ
リングされるデータの量に全く依存しないことです。そのため、この手法は非常に
スケーラブルで、大規模なデータに適しています。しかしながら、並列レンダリン
グのオーバーヘッドは画像中の画素数に対して線形に増加します。したがって、レ
ンダリング設定の幾つかは画像の大きさに関するものです。

IceTは、タイリング表示されたディスプレイ (多数の並べられたモニタやプロジェ
クタによって構成される、大型・高解像度のディスプレイ) を駆動する能力があり
ます。ソート・ラスト・アルゴリズムをタイリング・ディスプレイに使用するのは、
重畳すべき画素数が非常に多くなるため、やや直感的ではありません。しかしなが
ら IceTでは、それぞれのプロセスに存在するデータの特定の局所性を利用して、必
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要な重畳処理を大幅に低減するようになっています。この空間的な局所性は、デー
タに対しD3フィルタを適用することで強制することができます。
並列レンダリングにはオーバーヘッドが存在するため、ParaViewではいつでも並
列レンダリングをオフにすることができます。並列レンダリングがオフの時は、形
状データが実際に表示が行われる所に転送されます。明らかに、これはレンダリン
グするデータが小さいときにのみ行うべきです。

3.10.3 並列レンダリングの設定

他の 3次元レンダリングの設定と同じように、並列レンダリングの設定も Edit →

Settings (MacではParaView → Preferences)によって現れる設定ダイアログボックス
に配置されています。ダイアログを開くと、並列レンダリングの設定はRender View

→ Server以下にあります。それぞれの設定は、以下のような意味があります。

Remote Render Threshold (リモート・レンダリングを行うしきい値) こ の
チェックボックスは、リモート・レンダリングをオンまたはオフにします。ス
ライダによって、並列レンダリングを行うしきい値を変更することができま
す。形状のデータ量がこのしきい値未満であれば、形状データが表示が行わ
れる所 (通常はクライアント) に転送されます。

Disable Ordered Compositing (順序付け重畳を行わない) ボリューム・レンダ
リングおよび透明なポリゴンが正しく表示されるには、順序付け重畳と呼ば
れる特別な並列レンダリング・モードが必要です。しかしながら、このモード
には追加の計算処理とメモリが必要です。このチェックボックスをオンにする
と、順序付け重畳を行わなくなります。

Subsample Rate (間引き率) 並列レンダリングのオーバーヘッドは、生成された
画像の大きさに比例します。したがって、インタラクティブなレンダリングは、
画像を間引く割合を指定することで高速化することができます。このチェック
ボックスがチェックされている時は、インタラクティブ・レンダーでは低解像
度の画像を生成し、表示される時にその画像を拡大するようになります。こ
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の設定はインタラクティブ・レンダーの時のみ使用されます。スティル・レン
ダーの時は、常に完全な解像度の画像が使用されます。

Squirt Compression (Squirt圧縮) 画像がサーバからクライアントに転送される
前に、その画像をSQUIRTと呼ばれるアルゴリズムによって圧縮することが
できます。このチェックボックスでは、この SQUIRT圧縮をオンまたはオフに
します。圧縮をさらに効果的にするために、SQUIRTでは圧縮前に画像の色深
度を削減することができます。スライダによって、削減する色深度のビット数
を指定します。デフォルトの 19ビットでは、ほとんどのディスプレイではま
ず違いが判りません。スライダによる設定は、インタラクティブ・レンダーの
時のみ有効です。スティル・レンダーの時は、常にフルカラーの色深度が使用
されます。

Still Subsample Rate (スティル・レンダーの間引き率) タイリング・ディスプレ
イは色々な用途に使われます。例えば、小規模な共同作業や大規模なプレゼン
テーションなどです。大規模なプレゼンテーションでは、観衆がディスプレイ
の全ての画素を見ることはまずありません。そのような場合には、このオプ
ションによってスティル・レンダーの画像を間引いて、レンダリングの時間を
大幅に短縮することができます。

Client Collect (クライアントに集約する) タイリング・ディスプレイ・モードで
は、並列レンダリングによる画像はデスクトップでなく、タイリングされた
ディスプレイに送られます。したがって、クライアントは全てのデータをロー
カルにレンダリングしなければなりません。この設定では、クライアントに送
られるデータ量の上限を指定します。データが指定されたしきい値より大きけ
れば、クライアントにはデータが収まるバウンディング・ボックスのみが表示
されます。

Compositing Threshold (重畳を行うしきい値) 重畳を行うしきい値とは、タイ
リング・ディスプレイに対するリモート・レンダリングを行うしきい値と同等
のものです。ただし、重畳を行うことによる得失は異なります。タイリングさ
れたディスプレイは解像度が高いために重畳のオーバーヘッドは大きく、その
かわり通常は高速なネットワーク内で行われるため、形状の集約のオーバー
ヘッドは小さくなります。したがって、重畳を行うしきい値をリモート・レン
ダリングを行うしきい値よりも高くすると、効果のあることがあります。形状
のデータ量がこの重畳を行うしきい値より小さければ、表示される形状が全て
のレンダリング・ノードに送られ、それぞれのレンダリング・ノードはそれぞ
れが受け持つタイリング・ディスプレイの部分に直接レンダリングされます。
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3.10.4 大規模データのための設定
デフォルトのレンダリング設定は、ほとんどのユーザに適しています。しかしな
がら、非常に大規模なデータを扱う時は、設定を追い込むことが有効であることが
あります。最適な設定はデータおよび ParaViewが実行されるハードウエアによっ
て変わりますが、以下のような助言に従うと良いでしょう。

1. Use Immediate Mode Renderingをオンにして、Use Triangle Stripsをオフにし
て下さい。これらの設定は両方とも、効率的にレンダリング可能な構造に変換
することが目的です。しかしながら、データが大規模なときは大抵、処理とメ
モリのオーバーヘッドがその効率化に見合いません。実際、メモリの限界が拡
大されれば、この設定によって性能は低下します。

2. LOD Thresholdをオフにしてみてください。大規模データにおいては、形状の
簡略化には長い時間がかかり、データに極端な曲がり部や特殊なコネクティビ
ティがあれば、良い結果が得られないことがあります。LODによって性能が改
善されるのであれば、LOD Resolutionの設定スライダを一番右 (10× 10× 10)

に動かしてみて下さい。

3. 常にリモート・レンダリングをオンにしておいてください (Remote Render

Thresholdの隣のチェックボックスで切り替えられます)。リモート・レンダリ
ングによってサーバ全体のレンダリング能力が使われ、クライアントに画像が
転送されます。リモート・レンダリングがオフであれば、形状データがクライ
アントに転送されます。大規模なデータに対しては、形状データを転送するよ
りも画像を転送する方が必ず高速です。

4. 間引き処理をオンにして、Subsample Rateを必要に応じて調整して下さい。画
像の重畳に時間がかかる場合は、クライアントとサーバの間の接続が狭帯域で
あるか、非常に大きな画像をレンダリングしているときには間引き率を大きく
すると、インタラクティブ・レンダリングの性能が大幅に改善されることがあ
ります。

5. Squirt Compressionがオンであることを確認して下さい。この設定はデスクトッ
プへの画像表示性能に大きな影響があります。また、この設定によって引き起
こされる画質低下は最小限であり、かつ影響を受けるのはインタラクティブ・
レンダリング時のみです。
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このチュートリアルに参加頂き、ありがとうございました。ParaViewを使って、
大規模データの可視化を始めるのに充分なだけ勉強されたことでしょう。以下には、
さらに情報を得るための情報源を挙げます。

The ParaView Guideは、ParaViewと一緒に持っておくのにとても良い情報源で
す。ここで学んだ以外の多くの使用法や、多くの機能に関するより詳細な説明が得
られます。

Amy Henderson Squillacote. The ParaView Guide. Kitware, Inc., 2008. ISBN-10

1-930934-21-1.

ParaView Wikiは、ParaViewをセットアップして使用するのに役立つ情報が満載
です。特に、並列 ParaViewサーバをインストールしたい方は、そのためのビルド
およびインストールのページを必ずご参照ください。

http://www.paraview.org/Wiki/ParaView

http://www.paraview.org/Wiki/Setting up a ParaView Server

可視化や、ParaViewで利用可能なフィルタに関する詳細事項をさらに学ぶことに
興味がある場合は、以下の可視化に関するテキストを入手することをご一考下さい。

Will Schroeder, Ken Martin, and Bill Lorensen. The Visualization Toolkit. Kit-

ware, Inc., fourth edition, 2006. ISBN 1-930934-19-X.

ParaViewをカスタマイズしようとされているのであれば、上記の本およびウエブ・
ページに多くの情報があります。ParaViewが依存する可視化ライブラリの VTK、
GUIライブラリのQtの使用法に関する情報については、下記の本が参考となります。

Kitware Inc. The VTK Users Guide. Kitware, Inc., 2006.

Jasmin Blanchette and Mark Summerfield. C++ GUI Programming with Qt 4.

Prentice Hall, 2006. ISBN 0-13-187249-4 (邦訳: 杵渕 聡、杉田 研治 訳「入門
Qt 4 プログラミング」オライリー・ジャパン、2007年、ISBN 978-4-87311-

344-9).

http://www.paraview.org/Wiki/ParaView
http://www.paraview.org/Wiki/Setting_up_a_ParaView_Server
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もし並列可視化の設計や VTKパイプラインの機能に興味があるのであれば、以
下の技術論文があります。

James Ahrens, Charles Law, Will Schroeder, Ken Martin, and Michael Papka.“A

Parallel Approach for Efficiently Visualizing Extremely Large, Time-Varying

Datasets.”Technical Report #LAUR-00-1620, Los Alamos National Labora-

tory, 2000.

James Ahrens, Kristi Brislawn, Ken Martin, Berk Geveci, C. Charles Law, and

Michael Papka.“Large-Scale Data Visualization Using Parallel Data Stream-

ing.”IEEE Computer Graphics and Applications, 21(4): 34–41, July/August

2001.

Andy Cedilnik, Berk Geveci, Kenneth Moreland, James Ahrens, and Jean Farve.

“Remote Large Data Visualization in the ParaView Framework.”Eurographics

Parallel Graphics and Visualization 2006, pg. 163–170, May 2006.

James P. Ahrens, Nehal Desai, Patrick S. McCormic, Ken Martin, and Jonathan

Woodring. “ A Modular, Extensible Visualization System Architecture for

Culled, Prioritized Data Streaming.”Visualization and Data Analysis 2007,

Proceedings of SPIE-IS&T Electronic Imaging, pg 64950I-1–12, January 2007.

John Biddiscombe, Berk Geveci, Ken Martin, Kenneth Moreland, and David

Thompson. “ Time Dependent Processing in a Parallel Pipeline Architec-

ture.”IEEE Visualization 2007. October 2007.

もし ParaViewの並列レンダリングのアルゴリズムや構造に興味があるのであれ
ば、それらに関する技術論文もまた多数あります。

Kenneth Moreland, Brian Wylie, and Constantine Pavlakos.“ Sort-Last Parallel

Rendering for Viewing Extremely Large Data Sets on Tile Displays.”Pro-

ceedings of IEEE 2001 Symposium on Parallel and Large-Data Visualization

and Graphics, pg. 85–92, October 2001.

Kenneth Moreland and David Thompson.“From Cluster to Wall with VTK.”Pro-

ceddings of IEEE 2003 Symposium on Parallel and Large-Data Visualization

and Graphics, pg. 25–31, October 2003.

Kenneth Moreland, Lisa Avila, and Lee Ann Fisk.“Parallel Unstructured Volume

Rendering in ParaView.”Visualization and Data Analysis 2007, Proceedings

of SPIE-IS&T Electronic Imaging, pg. 64950F-1–12, January 2007.
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2分木法, 61

3D View, 8

3Dウィジェット, 24

3Dビュー, 8

AMR, 6

annotate time, 40

calculator, 13, 56

client collect, 64

clip, 13, 17, 19, 55, 58

compositing threshold, 64

contour, 13, 15, 56–58

cut, see slice

Display, 8

extract group, 14

extract subset, 14

extract group, 14, 57

extract selection, 36

extract subset, 14, 55, 58

extract surface, 16

glyph, 14, 22, 57

group, 14, 57

group datasets, 14

histogram, 26

IceT, 61

immediate mode rendering, 60

Information, 8

LOD, 59

LOD Threshold, 61

LODしき い値, 61

object inspector, 8

ordered compositing, 63

ParaView, 1

ParaViewサーバ, 2

pipeline browser, 8

plot over line, 23

plot selection over time, 35

Properties, 8

pvpython, 2

remote render threshold, 63

rendering interrupts, 61

slice, 13, 56, 58

SQUIRT, 64

stream tracer, 14

stream tracer, 14, 21, 56

subsample, 63

threshold, 13, 55, 58

triangle strips, 60

tube, 21

Visualization Toolkit, 2

VTK, 2

warp

vector, 14, 56

しきい 値, 13

アクティブ・ビュー, 18

アニメーション・ビュー, 37

アノーテート・タイム, 39, 40

イミディエイト・モード・レンダリン
グ, 60
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インタラクティブ・レンダー, 59

オブジェクト・インスペクタ, 8

カメラのリセット, 21

カメラのリンク, 19

カット, see スライス
キー・フレーム, 41

クライアント, 46

クライアント－サーバ, 47

クライアント－レンダー・サーバ－デー
タ・サーバ, 47

クライアントに集約する, 64

クリップ, 13

グリフ, 14

グループの抽出, 14

コンター, 13

ゴースト・セル, 51

サブセットの抽出, 14

スタンドアローン, 46

スプレッドシート・ビュー, 33

スティル・レンダー, 59

スライス, 13

セレクション・インスペクタ, 32

ソース, 8

ソート・ラスト, 61

プログラマブル・フィルタ, 43

チューブ, 21

メニューバー, 8

モード, 37

ツールバー, 8

テキスト・ソース, 38

テンポラル・インターポレータ, 38

データ・サーバ, 46

データセットのグループ化, 14

データ型, 4

ディテールのレベル, 59

トライアングル・ストリップ, 60

トラック, 41

ドック可能な, 8

ラバー・バンド, 31

リモート・レンダリングを行うし きい

値, 63

レンダー・サーバ, 46

レンダリングの中断, 61

ワープ
ベクトル, 14

バイナリ・スワップ法, 61

パイプライン・ブラウザ, 8

ヒストグラム, 26

ビルトイン, 46

フィルタ, 4, 13

ボリューム・レンダリング, 27

ポリゴン・データ (ポリ・データ), 5

マルチブロック, 5

一様直線格子 (画像データ), 4

可視化パイプライン, 13

階層化一様AMR, 6

階層化適応メッシュ分割, 6

外部界面, 50

間引き, 63

曲線格子 (構造格子), 5

空間的にコヒーレントな, 51

重畳, 61

重畳を行うしきい値, 64

順序付け重畳, 63

小面, 9

制御点, 29

浅いコピー, 54

線分上の値のプロット, 23

選択部分の抽出, 36

選択部分を時間に沿ってプロット, 35

伝達関数, 28

電卓, 13

等値面, 13

八分木, 6
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非一様直線格子 (直線格子), 5

非構造格子, 5

表示・非表示, 17

表面の抽出, 16

流線追跡, 14

連結状態, 17
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